
,-.'/010'2334150-63

7-84'$'9:'%$

!"#$%&'&$())*'+&",)

!"#$%&'&$"($"$)*"'#+
,+($-(".(+/
0-+$!"#$%&'&$1&(2$3(2+.$/+4&#+-
566-
7&'/$"'-1+.-
8"9+(:;$2"'/*&');$"'/$.+)<*"(3.:$&'93.%"(&3'

Draft Apple proprietary and confidential



,-.'/010'2334150-63

7-84'D'9:'%$

-".$/*,,0$+0$+/*$'*1$!"#$%&'&

=2&-$)<&/+$6.34&/+-$(2+$+--+'(&"*$&'93.%"(&3'$:3<$'++/$(3$)+($(2+$%3-($9.3%$:3<.
!"#$%&'&>

!"#$%"%&''#%"(')*+,%?"'($"$@<&#A$&'(.3$(3$(2+$9+"(<.+-$39$:3<.$!"#$%&'&B$8++$(2+$'+C(
-+#(&3';$ >

-$.%/."(.$+,%59(+.$:3<$#3''+#($"$/&-6*":;$A+:D3"./;$"'/$%3<-+$3.$(."#A6"/;$6.+--$(2+
631+.$D<((3'$3'$(2+$D"#A$39$:3<.$!"#$%&'&$"'/$:3<E.+$.+"/:$(3$)+($-(".(+/>$73.$/+("&*-;
-++$ $"'/$ >

0."3%4*%/3*5,%5##+--$:3<.$/3#<%+'(-;$623(3-;$%<-&#;$"66-;$#3'("#(-;$"'/$#"*+'/".-
"#.3--$"**$:3<.$/+4&#+-$1&(2$&G*3</>$5'/$<-+$:3<.$!"#$%&'&$1&(2$:3<.$&F8$/+4&#+-$(3$%"A+
"'/$.+#+&4+$623'+$#"**-$H.+@<&.+-$"'$+C(+.'"*$%&#.3623'+I$"'/$(+C(-;$#36:$"'/$6"-(+
"#.3--$/+4&#+-;$3.$#.+"(+$"'$J'-("'($K3(-63(>$L+".'$%3.+$&'$

$"'/$ >

6*&$"/7%3')(%5($".424.3,%M/&($623(3-;$3.)"'&N+$"*D<%-;$"'/$-2".+$%+%3.&+-$1&(2$O23(3-P
3.)"'&N+$"'/$*&-(+'$(3$%<-&#;$D33A-;$%34&+-;$"'/$%3.+$1&(2$&=<'+-P$#.+"(+$6.+-+'("(&3'-
1&(2$Q+:'3(+P$"'/$#2+#A$3<($"**$(2+$"66-$"4"&*"D*+$3'$(2+$ ;$(3$+C6.+--$:3<.-+*9

!"#$%&'&$"+$"$2,"'#*

="A+$"$(3<.

8+($<6 !&)."(+$:3<.$/"("

0$.%)1%"/%"%/$(2$(,%0-+$!"#$%&'&$"-$"$23%+$)"%&')$-+.4+.$12+.+$:3<$#.+"(+$"$6.&4"(+ 
13.*/$"'/$&'4&(+$3(2+.-$(3$6*":>$F.$<-+$!"#$%&'&$(3$6.34&/+$-+.4&#+-$&'#*</&')$7&*+$8+.4+.; 
G"#2&')$8+.4+.;$"'/$=&%+$!"#2&'+$-+.4+.>$73.$/+("&*-;$-++$8+.4+.>

5##+--$:3<.$#3'(+'(
"':12+.+$1&(2$&G*3</ 0-+$:3<.$!"#$%&'&$1&(2$&G*3</$"'/$G3'(&'<&(:$9+"(<.+-

566$8(3.+

Draft Apple proprietary and confidential



Mac mini Essentials

Page 3 of 81

in as many ways as you have ideas.

Dig deeper. Explore your Mac mini and get your questions answered. See 
.

Take a tour

Your Mac mini is packed with advanced technologies.

Power button: Press and hold for three seconds to turn your Mac mini on or off, or
press to put it to sleep.

Power port: Plug the power cord into the power port on the back of your Mac mini,
then plug the other end of the cord into a power outlet.

Gigabit Ethernet port: Connect a router or modem to use the Internet, or connect to
another computer to transfer files without using Wi-Fi.

10 Gigabit Ethernet (RJ-45) port: If your Mac mini has the optional 10 Gigabit
Ethernet port, it can use Nbase-T Ethernet technology, which supports multiple data
rates for speeds up to 10 Gbit/s over standard twisted pair copper cabling up to 100
meters (328 feet) in length. Depending on the device youʼre connecting to, the
cable type and technology used, and the cable length, the highest link speed is
automatically negotiated. For example, if the device youʼre connecting to is 10
Gbit/s-capable and the cable can support the speed, the two devices negotiate the
10 Gbit/s speed.

See the following chart for connection speeds and cable types. Speeds are for
cables up to 100 meters (328 feet) in length, unless otherwise specified.

macOS User
Guide
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Cable Type 1 Gbit/s 2.5 Gbit/s 5 Gbit/s 10 Gbit/s

Category 5e Not supported

Category 6  Up to 55 m
(180 feet)

Category 6a

Thunderbolt 3 (USB-C) ports: Transfer data at lightning-fast speeds, and connect a
display (such as the LG UltraFine 4K Display or LG UltraFine 5K Display), docking
stations, and RAID arrays. The ports can also charge devices, such as a
rechargeable trackpad or keyboard.

HDMI port: Use an HDMI to DVI Adapter or HDMI cable (sold separately) to connect
your Mac mini to a TV or external display.

USB 3 ports: Connect an iPad, iPhone, iPod, digital camera, external storage device,
or printer quickly and easily. The Mac mini USB 3 ports support USB 3 and USB 2
devices.

3.5 mm headphone jack: Plug in stereo headphones to experience high-quality
sound while watching movies, or a headset when playing games. Also use this port
to connect digital audio equipment to record sound or music, or plug in EarPods to
use with audio and video calls.

Status indicator light: A steady white light indicates your Mac mini is on; a pulsing 
light indicates itʼs in sleep mode.

Connect accessories

Plug in a compatible keyboard, mouse, trackpad, or other optional device to start using
Mac mini. You also need to connect a display when you first set up Mac mini (see

 for details).Connect a display

Draft Apple proprietary and confidential
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Note: The Thunderbolt 3 (USB-C) ports on your Mac mini are managed by two
controllers, one for the two left ports, the other for the two right ports. You can connect
one 5K display to a Thunderbolt 3 (USB-C) port, or up to three 4K displays using two
Thunderbolt 3 (USB-C) ports and the HDMI port.

To connect this device to Mac mini Use this cable or adapter

Thunderbolt 3 (USB-C) display Thunderbolt 3 (USB-C) cable

USB-C display USB-C (USB 3.1) cable

Thunderbolt 2 display Thunderbolt 3 (USB-C) to Thunderbolt 2
adapter

HDMI display or HDTV HDMI cable (you can also use a USB-C to HDMI
adapter or a USB-C Digital AV Multiport
adapter)

VGA display or projector USB-C VGA Multiport adapter

DisplayPort or Mini DisplayPort display USB-C to DisplayPort or Mini DisplayPort
adapter

DVI display or projector USB-C to DVI adapter

Adapters and other accessories are sold separately at , your local
Apple Store, and other retailers. Review the documentation or check with the
manufacturer to make sure you choose the right adapter.

apple.com
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Tip: If you donʼt see the Wi-Fi status icon  or Bluetooth icon  in the menu bar, you
can add them. For Wi-Fi, choose Apple menu  > System Preferences, then click
Network. Click Wi-Fi in the list on the left, then select “Show Wi-Fi status in menu bar.”
For Bluetooth, choose Apple menu  > System Preferences, click Bluetooth, then select
“Show Bluetooth in menu bar.”

Get an Apple ID. Your Apple ID is the account you use for everything you do with Apple—
including using the App Store, the iTunes Store, iCloud, Messages, and more. Your
Apple ID consists of an email address and a password. You need only one Apple ID to use
any Apple service, on any device—whether itʼs your computer, iOS device, Apple Watch,
or Apple TV. Itʼs best to have your own Apple ID and not share it—create a separate
Apple ID for each family member.

If you donʼt already have an Apple ID, you can create one (itʼs free). Go to 
.

Important: If you forget your Apple ID password, you donʼt need to create a new
Apple ID. Just click the Forgot link in the login window to retrieve your password.

Set up iCloud on your Mac mini. With iCloud, you can store all of your content—
documents, movies, music, photos, and more—in the cloud, and access it anywhere you
go.

To set up iCloud, choose Apple menu  > System Preferences, then click iCloud. In the
window that appears, enter your Apple ID and password. Then select the features you
want to use. To find out more, see .

Important: Be sure to use the same Apple ID for iCloud on all your devices.

For information about setting up and using Siri on your Mac mini, see .

the Apple ID
account website

Access your content anywhere with iCloud

Siri
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Quick Actions. At the bottom right of the Preview pane are shortcuts that let you
manage and edit files right in the Finder. You can rotate an image, annotate or crop an
image in Markup, combine images and PDFs into a single file, trim audio and video files,
and create custom actions through Automator workflows (for example, watermarking a
file). To learn more, see .

To show the Preview pane options in the Finder, choose View > Show Preview. To
customize whatʼs shown, choose View > Show Preview Options, then select the options
for your file type.

The Dock

The Dock, at the bottom of the screen, is a convenient place to keep the apps and
documents you use frequently.

Open an app or file. Click its icon in the Dock. Recently opened apps appear in the
center section of the Dock.

Add an item to the Dock. Drag the item and drop it where you want it. Place apps in the
left section of the Dock, and files or folders in the right section.

Perform quick actions in the Finder on Mac
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Remove an item from the Dock. Drag it out of the Dock. The item isnʼt removed from
your Mac mini—just from the Dock.

Tip: You can make the Dock larger or smaller, add or remove items, move it to the left
or right side of the screen, or even set it to hide when youʼre not using it. To change how
the Dock looks, click the System Preferences icon  in the Dock, or choose
Apple menu  > System Preferences. Then click Dock.

Quickly open apps

Your Mac mini comes with apps for all the things you love to do—browse the web, check
email, share photos, enjoy movies, and more.

Open an app. Click an app icon in the Dock, or click the Launchpad icon  in the Dock,
then click the app you want. You can also search for an app using Spotlight, then open
the app directly from your Spotlight search results.

Organize apps in Launchpad. Launchpad organizes your apps in a grid. Drag an app to
a new location to rearrange apps. Drag an app onto another app to create a folder. Drag
more apps to the new folder to add them. To remove an app from a folder, drag it out.

Get more apps. Click the App Store icon  in the Dock and search for apps you want.
Apps you download from the App Store appear automatically in Launchpad. To quickly
get updates for apps and macOS, click Updates in the App Store.

Draft Apple proprietary and confidential
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Whatʼs new

New macOS features

macOS Mojave offers many exciting new features, including:

Dark Mode: Use a dark color scheme for the Desktop, menu bar, Dock, and all the
built-in apps on macOS. Your content stands out front and center while darkened
controls and windows recede into the background. For more information, see 

.

Desktop: The default desktop background adjusts to match the time of day in your
time zone. And you can use stacks to automatically organize files on your desktop by
file type, kind, date, or tag. For more information, see 

.

Finder: Large previews let you view and quickly locate files in the new Gallery View.
Use the Preview pane to view all of a fileʼs metadata. Perform basic edits like rotating
images and creating PDFs in the Finder with Quick Actions. For more information, see

.

Quick Look: Select a file and press the Space bar to open Quick Look. You can sign
PDFs; trim audio and video files; and mark up, rotate, and crop images without
opening a separate app. To learn more about Quick Look and markup features, see

 and  in the macOS
User Guide.

Screenshot utility: The easy-to-use menu lets you take screenshots and screen
recordings that can include your voice (requires an external microphone, available
separately). You can also set a start timer, show the cursor, and customize where to
save your screenshots. A new workflow makes it easier to save, edit, and share what
you capture. For more information, see .

Continuity Camera: Use your iPhone or iPad camera to insert an image directly within
a document on your Mac, or save it as a file in the Finder. You can also scan a
document using your iOS device and save it to your Mac as a PDF file. For more
information, see .

App Store: A redesigned sidebar in the App Store makes it easier for you to browse,
search, and filter apps. Read in-depth stories and explore curated collections on the
Discover tab. For more information, see .

Dark
Mode

The desktop, menu bar, and
Help

The Finder

View and edit files with Quick Look on Mac Mark up files on Mac

Screenshot utility

Continuity Camera

App Store
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Security and Privacy: Your Mac asks for permission before granting apps access to a
wide range of tools and personal data. Enhanced privacy protections in Safari make it
harder for data companies to track your web browsing. Safari also automatically
suggests and stores unique, strong passwords when you sign up for an account, and
identifies passwords that have been reused so you can easily change them. For more
information, see .

Additionally, macOS Mojave brings four new apps to Mac:

Apple News: Browse trusted news and information thatʼs been curated by editors and
personalized for you. You can save articles for future reading—even offline or on
other devices. For more information, see .

Stocks: Customize your watchlist to follow stocks, indexes, currencies, and more.
View prices and interactive charts, and read high-quality business news right in the
app. For more information, see .

Voice Memos: Record and edit audio clips on your Mac. Sync and listen to recordings
on all your devices using iCloud. For more information, see .

Home: Control your HomeKit accessories using your Mac. The Home app lets you
automate accessories; create scenes, which allow accessories to work together with
a single command; and get real time notifications if something happens in your home.
You can also use Siri to control accessories when the app isnʼt running. For more
information, see .

Dark Mode

Dark Mode transforms your desktop picture, menu bar, Dock, and built-in apps to a dark
color scheme. It makes your content stand out while darkened controls and windows
recede into the background, so itʼs easier to stay focused on your work.

Perfect for pros. Dark Mode is finely tuned for professionals who edit photos and
images—colors and fine details pop against the dark app backgrounds. But itʼs also great
for anyone who just wants to focus on their content.

Easy on your eyes. In Dark Mode, macOS shows white text on a black background in
apps such as Mail, Contacts, Calendar, and Messages, so itʼs easier on your eyes when
youʼre working in dark environments.

Safari

Apple News

Stocks

Voice Memos

Home
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Beautiful new look. Dark Mode is a great way to give your Mac a new look that makes
your content shine in apps like Photos, iTunes, Messages, and Keynote. Itʼs been
integrated throughout macOS and its apps, so you can stay fully immersed in your work.

Learn more. To learn more, see .

Screenshot utility

Explore the Screenshot menu to find all the controls you need to take screenshots and
screen recordings. You can also capture your voice during a screen recording. (Mac mini
requires an external microphone to record your voice. Accessories are sold separately at
apple.com or your local Apple Store.) The optimized workflow lets you capture photos
and videos of your screen, and then easily share, edit, or save them.

Access the screenshot controls. Press Command-Shift-5. You can capture the entire
screen, a selected window, or a portion of a window. You can also record the entire
screen or a selected portion of the screen.

Use the icons at the bottom of the screen to capture a selection , record your screen 
, and more. Click Options to specify where you want to save the screenshot, set a

timer before capturing, set microphone and audio options, or show elements like the
pointer. Click Capture to save the screenshot.

After you take a screenshot or video, a thumbnail appears in the corner of your screen.
Drag it into a document or folder, swipe to the right to quickly save it, or click to edit or
share it.

Note: You can also open the Screenshot utility from the Other folder in Launchpad or
from the Apps > Utilities folder in Finder.

Use a light or dark appearance on your Mac
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If your Mac mini doesnʼt start because it detects an untrusted component, it will
start from a secure recovery partition and automatically correct issues if possible. To
learn more about the Startup Security Utility or to find out how to set other options,
such as starting up from an external device, see the Apple Support article 

.

Server

The most popular server features—File Server, Time Machine Server, and Caching
Server—are a part of macOS, so itʼs easy to use your Mac mini as a server. Click the
System Preferences icon  in the Dock, then click Sharing to select one or more of the
options below.

File Sharing: lets users store and share folders and files on Mac mini. For more
information, see .

Time Machine: lets users back up their Mac computers on your Mac mini using File
Sharing. For more information, see .

Content Caching: provides caching of software distributed by Apple through the
Internet. For more information, see .

Migrate your data

Itʼs easy to move your files and settings from another Mac or PC to your Mac mini. To
transfer the data when you first set up your Mac mini, use Setup Assistant. To transfer
data later, you can use Migration Assistant. If both computers are connected to the same
Wi-Fi network, you can transfer the data wirelessly.

Tip: For best results, make sure your Mac mini is running the latest version of macOS.
To check for software updates, click the App Store icon  in the Dock, then click
Updates in the App Store toolbar.

If you used Time Machine to back up your files from another Mac to a storage device
(such as an AirPort Time Capsule or an external disk), you can copy the files from the
device to your Mac mini.

About
Startup Security Utility

Use file sharing

Use a shared folder with Time Machine

Content caching preferences
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Use Migration Assistant. Open a Finder window, go to Applications > Utilities, then
double-click Migration Assistant. Follow the onscreen instructions. For more information,
see the Apple Support article .

Tip: For fastest migration, connect your old computer to your Mac mini with a cable,
such as a Lightning to USB cable or a Thunderbolt 3 (USB-C) cable. If you migrate
wirelessly, youʼll get best results if you keep both computers near each other
throughout the migration process.

Copy files from a storage device. Connect the device to the USB 3 port  or
Thunderbolt 3 (USB-C) port  on your Mac mini, then drag files from your storage
device to your Mac mini.

Use Target Disk Mode. You can transfer data from a Thunderbolt-equipped Mac to your
new Mac mini using a Thunderbolt cable. Put the Mac you want to migrate data from in
Target Disk Mode by restarting it while holding down the T key. Then connect the two
computers using a Thunderbolt cable, and open Migration Assistant on your Mac mini.
Select “From a Mac, Time Machine backup, or startup disk” when asked how you want to
transfer your information, click Continue, then select the disk you want to transfer
information from.

Save space on your Mac mini

With Optimize Storage, you can automatically free up space on your Mac mini by making
files available on demand. Your files will be stored in iCloud Drive, iCloud Photos
(formerly called iCloud Photo Library), iCloud, and iTunes, as well as on your email IMAP
or Exchange server, so you can download them at any time. In addition, there are tools to
identify and delete big files.

How to move your content to a new Mac
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iTunes: Choose to automatically remove iTunes movies or TV shows from your
Mac mini after you watch them. Your watched videos are still available on demand.

Mail: Choose to have Mail download only recent email attachments, or none at all.
If you choose to download only recent attachments, your oldest email
attachments are still available on demand.

Empty Trash Automatically: Automatically erase items that have been in the Trash for
more than 30 days.

Reduce Clutter: Easily identify large files, and delete the files you no longer need. To
browse large files, click through the categories in the sidebar—Documents,
Applications, Music Creation, iOS Files, and more.

To help you save space as you work, macOS also:

Prevents you from downloading the same file twice from Safari

Alerts you to remove installer software when you finish installing a new app

Clears logs and caches that are safe to remove when youʼre low on storage

Back up and restore

To keep your files safe, itʼs important to back up your Mac mini regularly. The easiest way
to back up is to use Time Machine—which is built into your Mac mini—with an external
storage device connected to your Mac mini. Time Machine can also back up your Mac
contents to supported network volumes. For a list of devices supported by Time
Machine, see the Apple Support article .

Files stored in iCloud Drive and photos in iCloud Photos are automatically backed up to
the cloud and donʼt need to be part of your Time Machine or other backup.

Tip: You can use a shared Mac thatʼs on the same network as your Mac mini as a
backup destination. On the other Mac, go to System Preferences > Sharing, then turn on
File Sharing. Add a shared folder, secondary click (that is, right-click) the folder, choose
Advanced Options, then click “Share as Time Machine backup destination.”

Set up Time Machine. Make sure your Mac mini is on the same Wi-Fi network as your
external storage device, or connect your storage device to your Mac mini. Click the
System Preferences icon  in the Dock, click Time Machine, then select Back Up
Automatically. Select the drive you want to use for backup, and youʼre all set.

Backup disks you can use with Time Machine

Draft Apple proprietary and confidential
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Time Machine:

Automatically backs up your entire Mac mini, including system files, apps, accounts,
preferences, music, photos, movies, and documents.

Remembers how your computer looked on any given day, so you can revisit your
Mac mini as it appeared in the past or retrieve an older version of a document.

Lets you restore your entire system from a Time Machine backup. So if anything
happens to your Mac mini, your files and settings are safe and sound.

Learn more. To learn more about backing up and restoring your Mac mini, see 
 in the macOS User Guide.

Back up
your files with Time Machine
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Use your Mac mini with iCloud and Continuity features

There are many ways to use your Mac mini with your other devices, such as iPhone, iPad,
iPod touch, or Apple Watch. You can transfer files, share and edit documents, unlock
your Mac mini with your Apple Watch, turn your iPhone or iPad into an Internet hotspot,
answer calls or send texts from your Mac mini, and more.

Access your content across devices. With iCloud, you can securely store, edit, and
share your documents, photos, and videos across devices to make sure youʼre always up
to date. To get started, see .

To sign in to iCloud if you didnʼt when you set up your Mac, click the System Preferences
icon  in the Dock, click iCloud, then sign in with your Apple ID, or create a new one if
you donʼt have one. To learn more, see  in the macOS User Guide.

Use your Mac mini with other devices. You can seamlessly move between your
Mac mini and other devices using Continuity. Just sign in to iCloud with your Apple ID,
and whenever your Mac mini and devices are near each other, they work together in great
ways. With Continuity features, you can do things like start a task on one device and
finish it on another (see ), copy and paste between devices (see 

), answer calls or send texts from your Mac mini (see 
), transfer files with AirDrop (see ), and more.

For a list of system requirements for devices that support Continuity, see the
Apple Support article . To learn more about using
Continuity with your Mac mini, see the Apple Support article 

 or go to .

Use Mac mini with other devices

Access your content anywhere with iCloud

Set up iCloud

Handoff Universal
Clipboard Phone calls and text
messages AirDrop

System requirements for Continuity
Use Continuity to connect

your Mac, iPhone, iPad, iPod touch, and Apple Watch All your devices

Draft Apple proprietary and confidential
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Access your content anywhere with iCloud

iCloud is the easiest way to make sure all your important content is everywhere you are.
iCloud stores your documents, photos, music, apps, contacts, and calendars, so you can
access them anytime youʼre connected to the web.

You can use your Apple ID to set up a free iCloud account, which comes with 5 GB of free
storage space. Purchases you make from the iTunes Store, App Store, or Apple Books
donʼt count toward your available space.

iCloud keeps everything up to date on your devices. So if you have an iPhone, iPad, or
iPod touch, just sign in to iCloud using the same Apple ID and youʼll have everything you
need.

For system requirements about devices that support iCloud, see the Apple Support
article .

Here are some of the things you can do with iCloud.

Automatically store your desktop and Documents folder in iCloud Drive. You can
save files in your Documents folder or on your desktop, and theyʼre automatically
available on iCloud Drive and accessible wherever you are. When working with
iCloud Drive, you have access to files on your Mac mini, on your iPhone or iPad in the
iCloud Drive app, on the web at iCloud.com, or on a Windows PC in the iCloud app. When
you make changes to a file on a device or on iCloud Drive, youʼll see your edits wherever
you view the file.

To get started, click the System Preferences icon  in the Dock, click iCloud, select
iCloud Drive, click Options, then select “Desktop & Documents Folders.” To learn more,
see the Apple Support article .

System requirements for iCloud

Use iCloud Drive on iCloud.com
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Learn more. To learn more about iCloud, see  in the macOS User Guide.

Handoff

With Handoff, you can continue on one device where you left off on another. Work on a
presentation on your Mac mini, then continue on your iPad. Or start an email message on
your iPhone, then finish it on your Mac mini. View a message on your Apple Watch, and
respond to it on your Mac mini. You donʼt have to worry about transferring files. When
your Mac mini and devices are near each other, an icon appears in the Dock whenever an
activity can be handed off; to continue, just click the icon.

Turn on Handoff on your Mac mini. Click the System Preferences icon  in the Dock,
click General, then select “Allow Handoff between this Mac and your iCloud devices.”

Turn on Handoff on your iOS device. Go to Settings > General > Handoff, then tap to
turn on Handoff. If you donʼt see the option, your iOS device doesnʼt support Handoff.

Turn on Handoff on your Apple Watch. In the Apple Watch app on iPhone, go to
Settings > General, then tap to turn on Enable Handoff.

Note: To use Handoff, you need an iPhone, iPad, or iPod touch with the Lightning
connector and iOS 8 (or later) installed. Make sure your Mac mini and iOS device have
Wi-Fi and Bluetooth turned on and are logged in with the same Apple ID.

Handoff works with Safari, Mail, Calendar, Contacts, Maps, Messages, Notes, Reminders,
Keynote, Numbers, and Pages.

Learn more. To learn more about Handoff, see  in
the macOS User Guide.

Universal Clipboard

Copy content from one device, and paste it into another nearby device within a short
period of time. The contents of your clipboard are sent over Wi-Fi and made available to
all Mac and iOS devices that are logged in with the same Apple ID and have Handoff, Wi-
Fi, and Bluetooth turned on. For more information, see .

What is iCloud?

Pick up where you left off with Handoff

Handoff
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Note: To use Universal Clipboard, you need an iPhone, iPad, or iPod touch with the
Lightning connector and iOS 10 (or later) installed.

Use across apps. You can copy and paste images, text, photos, and video between any
apps that support copy and paste on your Mac, iPhone, iPad, and iPod touch.

Copy and paste files. You can quickly move files from one Mac to another using
Universal Clipboard. Copy a file on your Mac mini and paste it into a Finder window, Mail
message, or any app that supports copy and paste on a nearby Mac. You must be signed
in with the same Apple ID on both Macs.

Learn more. To learn more about Universal Clipboard, see 
 in the macOS User Guide.

Continuity Camera

You can use your iPhone or iPad to take a scan or a photo of something nearby and insert
it into a document on your Mac. Scan a document or take a picture of something with
your iPhone or iPad camera, and it appears where you want it on your Mac.

Insert an image. In an app like Mail, Notes, or Messages, select where you want the
image to go, choose File > Import From iPhone or iPad, choose “Take Photo or Scan
Documents”, then take the photo or scan the image on your iOS device. You might need
to select your iOS device before taking the photo. Tap Use Photo or Keep Scan. You can
also tap Retake if you want to try again.

In an app such as Pages, select where you want the image to be inserted, then secondary
click (this is, right-click), choose “Import image,” then take the photo. You might need to
select your iOS device before taking the photo.

Note: To take a scan on your iOS device, drag the frame until what you want to show is in
the frame, tap Keep Scan, then tap Save. Tap Retake to rescan the content.

Copy and paste across
devices from your Mac
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Tip: If you donʼt see the recipient in the AirDrop window, check that the recipient can
be discovered by you and make sure both devices have AirDrop and Bluetooth turned on
and are within 30 feet (9 meters) of each other.

Learn more. To learn more about AirDrop, see 
 in the macOS User Guide.

Phone calls and text messages

You can take calls—and make them—right from your Mac mini. (Requires an external
microphone. Accessories are sold separately at  or your local Apple Store.) You
can also receive and send text messages.

Note: A Wi-Fi connection is required in order to make or receive phone calls on your
Mac mini.

Take or make a call. When someone calls your iPhone, click the notification that appears
on your Mac mini screen and your Mac mini becomes a speakerphone. If you want to
make a call, click a phone number in a Spotlight search or in an app such as FaceTime,
Contacts, Safari, or Calendar. You need a nearby device (iPhone or iPad) with a cellular
connection in order to make phone calls.

Send and receive messages. Send and receive SMS and MMS text messages right from
your Mac mini. When friends and family text you, you can respond with whichever device
is closest. All messages appear on your Mac mini, iPhone, iPad, iPod touch, and
Apple Watch. (Voice messages require an external microphone. Accessories are sold
separately at  or your local Apple Store.) For more information, see .

Use AirDrop on your Mac to send files to
devices near you

apple.com

apple.com Messages
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Learn more. To learn more about phone calls and text messages, see 
 in the FaceTime User Guide and 

 in the Messages User Guide.

Instant Hotspot

Lost your Wi-Fi connection? Use the Personal Hotspot on your iPhone or iPad to connect
your Mac mini to the Internet.

Note: Personal Hotspot requires an iPhone or a cellular model iPad, with iOS 8 or later.

Connect to your deviceʼs Personal Hotspot. Click the Wi-Fi status icon  i​n the menu
bar, then choose your iPhone or iPad from the list of devices that appears. (You donʼt
need to do anything on your device—Mac mini connects automatically.)

Check the status of your connection. Look in the Wi-Fi status menu to see the strength
of the cellular signal.

When youʼre not using the hotspot, your Mac mini disconnects to save battery life.

Learn more. To learn more about using Instant Hotspot, see 
 in the macOS User Guide.

Make and receive
phone calls in FaceTime on Mac Set up iPhone to get
SMS texts on Mac

Use an iPhone or iPad to
connect to the Internet
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Unlock your Mac mini with Apple Watch

Use your authenticated Apple Watch to automatically unlock your Mac mini when youʼre
within about three meters of your computer. Just wake your Mac and start using it—no
need to enter a password. Auto Unlock uses strong encryption to provide secure
communication between your Apple Watch and Mac mini.

Note: Auto Unlock is a feature for Macs (mid-2013 or later) running macOS Sierra or later,
and Apple Watch running watchOS 3 or later.

Set up two-factor authentication for your Apple ID. Auto Unlock works when your
Apple ID has two-factor authentication turned on. Go to Apple menu  > System
Preferences > iCloud > Account Details, click Security, then select Set Up Two-Factor
Authentication. For more information, see the Apple Support article 

.

Make sure “Disable automatic login” is also selected. (You wonʼt see this option if youʼre
using FileVault, but you can still use the Auto Unlock feature.)

Set up Auto Unlock. Sign in to iCloud with the same Apple ID on all your devices, then
click the System Preferences icon  in the Dock, or choose Apple menu  > System
Preferences. Click Security & Privacy, then select “Allow your Apple Watch to unlock your
Mac.”

Note: Auto Unlock works only when your Apple Watch is authenticated. You authenticate
your Apple Watch each time you put it on, so no extra steps are required after you enter
your passcode.

Two-factor
authentication for Apple ID
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For more information about using Apple Pay, see the Apple Support article 
.

AirPlay

Show whateverʼs on your Mac mini on the big screen using AirPlay Mirroring. To mirror
the Mac mini screen on your TV screen or to use the HDTV as a second display, connect
your HDTV to Apple TV and make sure the Apple TV is on the same Wi-Fi network as your
Mac mini. You can also play some web videos directly on your HDTV without showing
whatʼs on your desktop—handy when you want to play a movie but keep your work
private.

Mirror your desktop using AirPlay Mirroring. Click the AirPlay icon  in the menu bar,
then choose your Apple TV. When an AirPlay display is active, the icon turns blue.

In some cases, you can use an AirPlay display even if youʼre not on the same Wi-Fi
network as Apple TV (called peer-to-peer AirPlay). To use peer-to-peer AirPlay, you need
an Apple TV (3rd generation rev A, model A1469 or later) with tvOS 7.0 or later.

Play web videos without showing your desktop. When you find a web video with an
AirPlay icon , click the icon, then select your Apple TV.

Tip: If the image doesnʼt fit your HDTV screen when you mirror the screen, adjust the
desktop size for the best picture. Click the AirPlay icon , then choose an option under
“Match Desktop Size To.”

Apple TV is sold separately at  or your local Apple Store.

Learn more. To learn more about AirPlay, see 
 in the macOS User Guide. To learn more about using a second display with

your Mac mini, see .

Using Apple
Pay in stores, within apps, and on the web

apple.com

Use AirPlay to stream what's on your Mac
to an HDTV

Connect a display
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AirPrint

You can use AirPrint to print wirelessly to:

An AirPrint-enabled printer on your Wi-Fi network

A network printer or printer shared by another Mac on your Wi-Fi network

A printer connected to the USB port of an AirPort base station

Print to an AirPrint printer. When you print from an app, click the Printers pop-up menu
in the Print dialog, choose Nearby Printers, then choose an AirPrint printer.

Canʼt find the printer youʼre looking for? Make sure itʼs connected to the same Wi-Fi
network as your Mac mini. If it is connected and you still donʼt see it, try adding it: Click
the System Preferences icon  in the Dock, click Printers & Scanners, then click Add 

. (You may have to temporarily connect the printer to your Mac mini using a USB cable.)

Learn more. To learn more about AirPrint, see 
 in the macOS User Guide.

For a list of AirPrint-enabled printers and other supported printers, see the Apple Support
articles  and .

Print wirelessly from your Mac to an
AirPrint printer

About AirPrint Printer and scanner software available for macOS

Draft Apple proprietary and confidential
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L'#,59*9$"::)

R3<.$!"#$%&'&$#3%+-$1&(2$"$#3**+#(&3'$39$).+"($"66-$93.$(2&')-$:3<$/3$+4+.:$/":;$*&A+
-<.9&')$(2+$1+D;$-+'/&')$%"&*$"'/$%+--")+-;$"'/$".."')&')$:3<.$#"*+'/".>$J($"*-3$#3%+-
1&(2$"66-$*&A+$O23(3-;$&!34&+;$,".")+a"'/;$O")+-;$V<%D+.-;$"'/$Q+:'3(+f-3$:3<$#"'
D+$#.+"(&4+$"'/$6.3/<#(&4+$.&)2($9.3%$(2+$-(".(>$=2+$"66-$(2"($#3%+$1&(2$:3<.$!"#$%&'&
".+$/+-#.&D+/$&'$(2+$93**31&')$-+#(&3'->

L4*+%$2$*%J'($%"11/,%G*&#A$(2+$566$8(3.+$&#3'$ $&'$(2+$[3#A$(3$9&'/$"66-$93.$+4+.:(2&')
:3<$1"'($(3$/3>$8++$ $(3$*+".'$%3.+>

-$.%7$&1%M'(%"*3%"11,%G*&#A$(2+$K+*6$%+'<$H&'$(2+$%+'<$D".$"($(2+$(36$39$(2+$-#.++'I
12+'$:3<E.+$<-&')$"'$"66>

8::$-+06*

8+".#2$(2+$566$8(3.+$(3$9&'/$"'/$/31'*3"/$"66-;$"'/$)+($(2+$*"(+-($<6/"(+-$93.$:3<.
"66->

8::)

566$8(3.+

Draft Apple proprietary and confidential
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7-84'G$'9:'%$

L4*+%.7$%1$(M$5.%"11,%Q'31$+C"#(*:$12"($:3<E.+$*33A&')$93.B$=:6+$(2+$'"%+$&'$(2+$-+".#2
9&+*/;$(2+'$6.+--$_+(<.'>

F&&%3')%*$$+%4/%"*%F11&$%N8,%=3$/31'*3"/$"66-;$e<-($-&)'$&'$1&(2$:3<.$566*+$J[f#233-+
8(3.+$d$8&)'$J';$3.$#*&#A$8&)'$J'$3'$(2+$*+9($-&/+$39$(2+$1&'/31>$J9$:3<$/3'E($2"4+$"'
566*+$J[$:+(;$#233-+$8(3.+$d$G.+"(+$5##3<'(>$J9$:3<$#"'E($.+%+%D+.$:3<.$6"--13./;$#*&#A
(2+$73.)3($*&'A$(3$.+#34+.$&(>

-$.%.7$%&".$/.%)1+".$/,%J9$:3<$-++$"$D"/)+$3'$(2+$566$8(3.+$&#3'$&'$(2+$[3#A;$(2+.+$".+
<6/"(+-$"4"&*"D*+$93.$:3<.$"66-$3.$%"#F8>$G*&#A$(2+$&#3'$(3$36+'$566$8(3.+;$(2+'$#*&#A
06/"(+-$&'$(2+$(33*D".>

!41G%R3<$#"'$-6.+"/$(2+$13./$"D3<($:3<.$9"43.&(+$"66-$(3$:3<.$9.&+'/->$?2&*+$4&+1&')
"'$"66;$#*&#A$(2+$/31'$"..31$'+C($(3$(2+$6.&#+;$(2+'$#233-+$=+**$"$7.&+'/>

V$"(*%J'($,%=3$*+".'$%3.+$"D3<($(2+$566$8(3.+;$-++$(2+$ >

8::,*$I004)

0-+$566*+$a33A-$(3$.+"/$"'/$3.)"'&N+$:3<.$*&D.".:$39$D33A-;$"'/$(3$6<.#2"-+$'+1$D33A-
3'$:3<.$!"#>

566$8(3.+$0-+.$,<&/+

Draft Apple proprietary and confidential

https://support.apple.com/guide/app-store/welcome


Mac mini Essentials

Page 42 of 81

A bookshelf right on your Mac. Browse or search all the items in your library—or click
Book Store to find new books and other publications. To buy an item, just sign in with
your Apple ID (choose Store > Sign in.)

Never lose your place or your markups. Your purchased books, collections, highlights,
notes, bookmarks, and the current page youʼre reading are available automatically on
your Mac and iOS devices, as long as youʼre signed in on them with the same Apple ID.

Find your way back. You can quickly go to pages youʼve bookmarked. Click the arrow
next to  to view your list of bookmarks.

Tip: Change to Night theme to read more easily in low-light situations. Choose View >
Theme, then choose Night, or click the Fonts button , then click the black circle. Not
all books support Night theme.

Draft Apple proprietary and confidential
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V$"(*%J'($,%=3$*+".'$%3.+$"D3<($566*+$a33A-;$-++$(2+$ >

8::,*$B*1)

566*+$V+1-$&-$"$3'+S-(36$/+-(&'"(&3'$93.$(.<-(+/$'+1-$"'/$&'93.%"(&3';$#<."(+/$D:
+/&(3.-$"'/$6+.-3'"*&N+/$93.$:3<>$R3<$#"'$-"4+$".(&#*+-$93.$9<(<.+$.+"/&')f+4+'$399*&'+
3.$3'$3(2+.$/+4&#+->

N")$+&566*+$V+1-$&-$"4"&*"D*+$&'$(2+$0>8>;$0Q;$"'/$5<-(."*&">

:)/.'J4Q$%3')(%M$$+,%`&+1$(2+$'+1-$3<(*+(-$"'/$(36&#-$(2"($&'(+.+-($:3<$%3-(>$=3$#.+"(+
"$'+1$#2"''+*$&'$(2+$-&/+D".;$+'(+.$"$'+1-$3<(*+($3.$(36&#$&'$(2+$-+".#2$9&+*/;$(2+'$#*&#A$
(3$93**31$&(>

W"249".$%$"/4&3%R4.7%.7$%/4+$;"(,%0-+$(2+$-&/+D".$(3$@<&#A*:$#*&#A$D+(1++'$#2"''+*->$=3
"/e<-($(2+$3./+.$39$(2+$-&/+D".$#3'(+'(-;$#*&#A$+/&(;$(2+'$<-+$(2+$2"'/*+$(3$/.")$"'/$/.36
(2+$#2"''+*-$&'(3$(2+$3./+.$:3<$6.+9+.>

!41G%J9$:3<E.+$.+"/&')$"'$".(&#*+$"'/$1"'($(3$-"4+$&($93.$*"(+.;$#233-+$7&*+$d$8"4+$8(3.:>
=3$4&+1$(2+$".(&#*+$*"(+.;$#*&#A$8"4+/$8(3.&+-$"($(2+$D3((3%$39$(2+$-&/+D".>$R3<$#"'$"##+--
".(&#*+-$9.3%$"':$39$:3<.$/+4&#+-$12+'$:3<$-&)'$&'$(3$&G*3</$1&(2$(2+$-"%+$566*+$J[>

V$"(*%J'($,%=3$*+".'$%3.+$"D3<($566*+$V+1-;$-++$(2+$ >

a33A-$0-+.$,<&/+

V+1-$0-+.$,<&/+

Draft Apple proprietary and confidential
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7",*'9"6

V+4+.$%&--$"'$"663&'(%+'($1&(2$G"*+'/".>$Q++6$(."#A$39$:3<.$D<-:$-#2+/<*+$D:$#.+"(&')
%<*(&6*+$#"*+'/".-;$"'/$%"'")+$(2+%$"**$&'$3'+$6*"#+>

:($".$%$2$*./,%G*&#A$ $(3$"//$"$'+1$+4+'(;$3.$/3<D*+S#*&#A$"':12+.+$&'$"$/":>$=3$&'4&(+
-3%+3'+;$/3<D*+S#*&#A$(2+$+4+'(;$#*&#A$(2+$5//$J'4&(++-$-+#(&3';$(2+'$(:6+$"'$+%"&*
"//.+-->$G"*+'/".$*+(-$:3<$A'31$12+'$:3<.$&'4&(++-$.+6*:>

0$$%"&&%3')(%5"&$*+"(/^'(%Z)/.%"%M$R,%G*&#A$(2+$G"*+'/".-$D<((3'$(3$-++$"$*&-($39$"**$:3<.
#"*+'/".-P$#*&#A$(2+$3'+-$:3<$1"'($(3$-++$&'$(2+$1&'/31>

F%5"&$*+"(%M'(%$2$(3%1"(.%'M%3')(%&4M$,%G.+"(+$-+6"."(+$#"*+'/".-f93.$+C"%6*+;$93.
23%+;$13.A;$"'/$-#233*f+"#2$1&(2$&(-$31'$#3*3.>$G233-+$7&*+$d$V+1$G"*+'/".$(3$#.+"(+$"
#"*+'/".;$(2+'$-+#3'/".:$#*&#A$H(2"($&-;$.&)2(S#*&#AI$(2+$#"*+'/".-$(3$#233-+$"$'+1$#3*3.>

07"($%"5('//%3')(%+$245$/%"*+%R4.7%'.7$(/,%?2+'$:3<E.+$-&)'+/$&'$(3$&G*3</;$:3<.
#"*+'/".-$".+$A+6($<6$(3$/"(+$3'$"**$:3<.$!"#-$"'/$&F8$/+4&#+->$R3<$#"'$"*-3$-2".+
#"*+'/".-$1&(2$3(2+.$&G*3</$<-+.->

Draft Apple proprietary and confidential
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!41G%J9$:3<$"//$"$*3#"(&3'$(3$"'$+4+'(;$G"*+'/".$-231-$:3<$"$%"6;$+-(&%"(+/$(."4+*
(&%+$"'/$(&%+$(3$*+"4+;$"'/$+4+'$(2+$1+"(2+.$93.+#"-(>

V$"(*%J'($,%=3$*+".'$%3.+$"D3<($G"*+'/".;$-++$(2+$ >

<"#*3&%*

!"A+$4&/+3$"'/$"</&3$#"**-$9.3%$:3<.$!"#$1&(2$7"#+=&%+>$H_+@<&.+-$"'$+C(+.'"*$#"%+."
"'/$%&#.3623'+>$5##+--3.&+-$".+$-3*/$-+6"."(+*:$"($ $3.$:3<.$*3#"*$566*+$8(3.+>I

H4+$'%'(%")+4'%'*&3]%G3''+#($"$#"%+."$"'/$%&#.3623'+$(3$:3<.$!"#$(3$%"A+$7"#+=&%+
4&/+3$#"**->$J9$&(E-$'3($#3'4+'&+'($(3$%"A+$"$4&/+3$#"**;$#*&#A$(2+$5</&3$D<((3'$(3$%"A+$"'
"</&3S3'*:$#"**>

?2+'$:3<$.+#+&4+$"$7"#+=&%+$&'4&("(&3';$:3<$#"'$#233-+$(3$e3&'$1&(2$e<-($4&/+3;$e<-($"</&3;
3.$D3(2>

!41G%?2&*+$"$4&/+3$#"**$&-$&'$6.3).+--;$:3<$#"'$/.")$(2+$-%"**$6&#(<.+S&'S6&#(<.+
1&'/31$(3$"':$#3.'+.$39$(2+$7"#+=&%+$1&'/31>

V$"2$%"%J$//"9$,%J9$:3<.$7"#+=&%+$4&/+3$#"**$&-$/+#*&'+/$3.$'3($"'-1+.+/;$#*&#A$!+--")+
(3$-+'/$"$(+C($%+--")+>

G"*+'/".$0-+.$,<&/+

"66*+>#3%

Draft Apple proprietary and confidential
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I"#$%"%17'*$%5"&&,%J9$:3<$2"4+$"'$&O23'+$1&(2$&F8$Z$3.$*"(+.;$%"A+$623'+$#"**-$.&)2($9.3%
:3<.$!"#$<-&')$7"#+=&%+>$j<-($%"A+$-<.+$:3<.$!"#$"'/$&O23'+$".+$-&)'+/$&'$(3$(2+$-"%+
&G*3</$"##3<'($"'/$2"4+$(2+$9+"(<.+$(<.'+/$3'>$HF'$:3<.$!"#;$36+'$7"#+=&%+;$#233-+
7"#+=&%+$d$O.+9+.+'#+-;$(2+'$-+*+#($hG"**-$9.3%$&O23'+>iI

N")$+&5$?&S7&$#3''+#(&3'$&-$.+@<&.+/$&'$3./+.$(3$%"A+$3.$.+#+&4+$#"**-$3'$:3<.$!"#$%&'&>

V$"(*%J'($,%=3$*+".'$%3.+$"D3<($7"#+=&%+;$-++$(2+$ >

;"6"2*I"'9

,".")+a"'/$&-$"'$"66$93.$#.+"(&');$.+#3./&');$"'/$-2".&')$:3<.$%<-&#>$J($2"-$+4+.:(2&')
:3<$'++/$(3$*+".'$(3$6*":$"'$&'-(.<%+'(;$1.&(+$%<-&#;$3.$.+#3./$"$-3')f:3<.$31'$23%+
.+#3./&')$-(</&3>

:($".$%"%*$R%1('Z$5.,%R3<$#"'$-(".($1&(2$"$-3')$(+%6*"(+;$-+*+#($"$(+%63;$A+:;$"'/$3(2+.
36(&3'-;$(2+'$#*&#A$_+#3./$"'/$-(".($6*":&')>$a<&*/$:3<.$-3')f93.$+C"%6*+;$1&(2$/&99+.+'(
(."#A-$"'/$*336->$G*&#A$n<&#A$K+*6$ $"'/$23*/$(2+$63&'(+.$34+.$&(+%-$(3$*+".'$12"($(2+:
".+$"'/$231$(2+:$13.A>

C(4*9%4*%.7$%;$".,%R3<$#"'$@<&#A*:$"//$/.<%-$(3$:3<.$6.3e+#($<-&')$[.<%%+.$L336->
G*&#A$(2+$L336$a.31-+.$ ;$(2+'$/.")$"$[.<%%+.$L336$ $&'(3$"'$+%6(:$6".($39$(2+$=."#A-
".+">$R3<$#"'$#<-(3%&N+$[.<%%+.$L336-$(3$9&($:3<.$-3');$<-&')$"$-&%6*+$-+($39$#3'(.3*->

U$5'(+%3')(%2'45$,%G3''+#($"$%&#.3623'+;$#233-+$=."#A$d$V+1$=."#A;$(2+'$-+*+#($(2+
%&#.3623'+$<'/+.$5</&3>$G*&#A$(2+$(.&"')*+$'+C($(3$[+("&*-$(3$-+($36(&3'-$93.$&'6<(;$3<(6<(;
"'/$%3'&(3.&');$(2+'$#*&#A$G.+"(+>$G*&#A$(2+$_+#3./$ $D<((3'$(3$-(".($(3$-(".($.+#3./&');
3.$(2+$O*":$D<((3'$ $(3$-(36$.+#3./&')>

7"#+=&%+$0-+.$,<&/+

Draft Apple proprietary and confidential
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7-84'G#'9:'%$

V$"(*%J'($,%=3$*+".'$%3.+$"D3<($,".")+a"'/;$-++$ >

?0%*

?&(2$(2+$K3%+$"66;$:3<$#"'$+"-&*:$"'/$-+#<.+*:$#3'(.3*$"**$39$:3<.$K3%+Q&($"##+--3.&+-
9.3%$:3<.$!"#>

F55$//'(3%5'*.('&,%5##+--3.&+-$-231$<6$&'$(2+$K3%+$"66$"-$(&*+-$1&(2$&#3'->$G*&#A$"'
"##+--3.:$(&*+$(3$#3'(.3*$&(f(<.'$*&)2(-$3'W399;$*3#AW<'*3#A$(2+$/33.;$4&+1$*&4+$#"%+."-;
"'/$%3.+>$R3<$#"'$"*-3$"/e<-($(2+$D.&)2('+--$39$"$*&)2(;$3.$(2+$(".)+($(+%6+."(<.+$39$"
(2+.%3-("(>

,".")+a"'/$8<663.(

Draft Apple proprietary and confidential
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7-84'G%'9:'%$

07"($+%F55$//,%R3<$#"'$-2".+$:3<.$23%+$1&(2$9"%&*:$%+%D+.-$3.$)<+-(-;$-3$(2+:$#"'
#3'(.3*$"##+--3.&+-$<-&')$(2+$K3%+$"66$3'$(2+&.$31'$566*+$/+4&#+->

:($".$%"%/5$*$,%G.+"(+$-#+'+-$(2"($"**31$:3<.$"##+--3.&+-$(3$13.A$(3)+(2+.$"($(2+$-"%+
(&%+$1&(2$"$-&')*+$#3%%"'/>$73.$+C"%6*+;$%"A+$"$,33/$V&)2($-#+'+$(2"($(<.'-$399$"**$39
(2+$*&)2(-;$#*3-+-$(2+$-2"/+-;$"'/$*3#A-$(2+$/33.$12+'$:3<$(<.'$&'$93.$(2+$'&)2(>

V$"(*%J'($,%=3$*+".'$%3.+$"D3<($K3%+;$-++$(2+$ >

&!0H&*

&!34&+$*+(-$:3<$(<.'$:3<.$23%+$4&/+3-$&'(3$D+"<(&9<*$%34&+-$"'/$K3**:133/S-(:*+$(."&*+.-
(2"($:3<$#"'$-2".+$1&(2$"$9+1$@<&#A$#*&#A->

NJ1'(.%"%24+$',%J%63.($4&/+3$9.3%$:3<.$&O23'+;$&O"/;$3.$&O3/$(3<#2;$9.3%$"$#"%+.";$3.
9.3%$%+/&"$9&*+-$"*.+"/:$3'$:3<.$!"#>$&!34&+$#.+"(+-$"$'+1$*&D.".:$"'/$+4+'($93.$:3<>

:($".$%P'&&3R''+D/.3&$%.("4&$(/,%!"A+$#*+4+.$(."&*+.-;$#3%6*+(+$1&(2$"'&%"(+/$)."62&#-
"'/$-3".&')$-3<'/(."#A->$j<-($"//$623(3-$"'/$4&/+3$#*&6-$"'/$#<-(3%&N+$(2+$#.+/&(->$=3
)+($-(".(+/;$#*&#A$(2+$V+1$D<((3'$ ;$#*&#A$=."&*+.;$#233-+$"$(+%6*"(+$9.3%$(2+$=."&*+.
1&'/31;$(2+'$#*&#A$G.+"(+>$5//$(2+$#"-($"'/$#.+/&(-$&'$(2+$F<(*&'+$("D;$"'/$"//$:3<.$31'
623(3-$"'/$4&/+3-$&'$(2+$8(3.:D3"./$("D>

K3%+$0-+.$,<&/+

Draft Apple proprietary and confidential
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!41G%8233(&')$4&/+3$1&(2$"$2"'/2+*/$/+4&#+$#"'$6.3/<#+$-2"A:$.+-<*(-;$D<($:3<$#"'
-("D&*&N+$(2+$4&/+3$-3$(2+$6*":D"#A$&-$-%33(2+.>$8+*+#($(2+$-2"A:$#*&6$&'$(2+$(&%+*&'+;$#*&#A
(2+$8("D&*&N"(&3'$D<((3'$ ;$(2+'$#*&#A$8("D&*&N+$82"A:$`&/+3>

V$"(*%J'($,%=3$*+".'$%3.+$"D3<($&!34&+;$-++$ >

&35'*)

&=<'+-$%"A+-$&($+"-:$(3$3.)"'&N+$"'/$+'e3:$(2+$%<-&#;$63/#"-(-;$%34&+-;$"'/$=`$-231-
:3<$2"4+f"'/$-236$93.$(2+$3'+-$:3<$1"'(>$&=<'+-$&'#*</+-$566*+$!<-&#$H12&#2$*+(-$:3<
*&-(+'$(3$%&**&3'-$39$-3')-$3'$/+%"'/I;$a+"(-$T$*&4+$."/&3;$"'/$G3''+#(;$"$9<'$1":$93.$9"'-
"'/$".(&-(-$(3$&'(+."#(>

N.\/%4*%3')(%&4;("(3,%R3<.$&=<'+-$*&D.".:$#3'("&'-$:3<.$%<-&#;$63/#"-(-;$%34&+-;$"'/$=`
-231->$G*&#A$(2+$%+'<$&'$(2+$(36S*+9($#3.'+.$(3$4&+1$"$#"(+)3.:$39$&(+%-;$3.$(3$-1&(#2$(3$"
/&99+.+'($*&D.".:>

&!34&+$8<663.(

Draft Apple proprietary and confidential
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L4*+%3')(%*$R%M"2'(4.$%/'*9,%G*&#A$73.$R3<$(3$D.31-+$"*D<%-$"'/$6*":*&-(-
.+#3%%+'/+/$93.$:3<$D"-+/$3'$(2+$".(&-(-$"'/$)+'.+-$:3<$*34+>$=2+$.+3.)"'&N+/;$+"-:S
(3S<'/+.-("'/$-+#(&3'-$2&)2*&)2($12:$+"#2$"*D<%$3.$6*":*&-($1"-$-+*+#(+/$93.$:3<>$73.
R3<$"*-3$-231-$63-(-$9.3%$".(&-(-$:3<$93**31;$-3$&(E-$+"-&+.$(2"'$+4+.$(3$/&-#34+.$'+1
%<-&#>

C('R/$%.7$%;$/.%'M%F11&$%I)/45,%G*&#A$a.31-+$(3$-++$'+1$%<-&#$"'/$+C#*<-&4+$.+*+"-+-
9.3%$566*+$!<-&#>$G233-+$9.3%$"$2<)+$-+*+#(&3'$39$6*":*&-(-$(3$9&'/$(2+$6+.9+#($%&C$93.
"':$%3%+'(>

!)*$%4*,%G*&#A$_"/&3$(3$(<'+$&'$(3$a+"(-$T$*&4+$3.$*&-(+'$(3$"':$+6&-3/+$9.3%$(2+$a+"(-$T
9"%&*:$39$-231->$MC6*3.+$(2+$1&/+$4".&+(:$39$%<-&#S3'*:$-("(&3'-$#.+"(+/$93.$"*%3-($+4+.:
)+'.+$39$%<-&#>

!41G%=3$6*":$%<-&#$3.$."/&3$9.3%$"$-6+"A+.$<-&')$5&.O*":;$#*&#A$(2+$5&.O*":$&#3'$ $&'
(2+$%+'<$D".$"'/$-+*+#($"'$"4"&*"D*+$-6+"A+.>

V$"(*%J'($,%=3$*+".'$%3.+$"D3<($&=<'+-;$-++$ >

M*.'0+*

G.+"(+$6.39+--&3'"*;$#<((&')S+/)+$6.+-+'("(&3'-$1&(2$Q+:'3(+>$8(".($1&(2$3'+$39$(2+$%3.+
(2"'$XU$6.+/+-&)'+/$(2+%+-$"'/$%"A+$&($:3<.$31'$D:$"//&')$(+C(;$'+1$3De+#(-;$"'/
<6/"(&')$(2+$#3*3.$-#2+%+>

T(9"*4Q$%24/)"&&3,%0-+$(2+$-*&/+$'"4&)"(3.$3'$(2+$*+9($(3$@<&#A*:$"//;$/+*+(+;$3.$.+".."')+
-*&/+->$G*&#A$"$-*&/+$(3$-++$&($&'$(2+$%"&'$1&'/31;$/.")$"$-*&/+$(3$#2"')+$&(-$3./+.;$3.$-+*+#(
&($"'/$6.+--$[+*+(+$(3$.+%34+$&(>

&=<'+-$8<663.(

Draft Apple proprietary and confidential
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,-.'/010'2334150-63

7-84'*$'9:'%$

X("5.45$%J"#$/%1$(M$5.,%=3$.+2+".-+$:3<.$6.+-+'("(&3';$#233-+$O*":$d$_+2+".-+
8*&/+-231>$R3<E**$-++$+"#2$-*&/+$"*3')$1&(2$:3<.$'3(+-f"'/$"$#*3#A$(3$A++6$:3<$3'$(."#A>

07"($%3')(%1($/$*.".4'*,%J9$:3<.$%"'")+.$1"'(-$(3$.+4&+1$:3<.$6.+-+'("(&3'$3.$:3<$1"'(
(3$-2".+$&($1&(2$3(2+.-$3'$"$#3'9+.+'#+$#"**;$#233-+$82".+$d$8+'/$"$G36:$(3$-+'/$"$#36:
D:$!"&*;$!+--")+-;$5&.[.36;$3.$+4+'$-3#&"*$%+/&">

L'&&'R%.7$%;')*54*9%;"&&,%,+($(2+&.$"((+'(&3'$D:$"'&%"(&')$"'$3De+#($3'$"$-*&/+>$8+*+#(
(2+$3De+#(;$#*&#A$5'&%"(+$&'$(2+$(33*D".;$#*&#A$5#(&3'$&'$(2+$-&/+D".;$(2+'$#*&#A$5//$"'
M99+#(>

!41G%R3<$#"'$&'#*</+$"$4&/+3$&'$:3<.$6.+-+'("(&3'>$G*&#A$12+.+$:3<$1"'($&($(3$D+;$(2+'
#*&#A$(2+$!+/&"$D<((3'$ $&'$(2+$(33*D".>$G*&#A$!34&+-;$9&'/$(2+$%34&+$:3<$1"'(;$(2+'$/.")
(2+$9&*+$(3$:3<.$-*&/+>

V$"(*%J'($,%=3$*+".'$%3.+$"D3<($Q+:'3(+;$-++$ >

!"&,

!"&*$*+(-$:3<$%"'")+$"**$:3<.$+%"&*$"##3<'(-$9.3%$"$-&')*+$"66>$J($13.A-$1&(2$%3-(
636<*".$+%"&*$-+.4&#+-;$-<#2$"-$&G*3</;$,%"&*;$R"233$!"&*;$"'/$5FL$!"&*>

T*$D/.'1%$J"4&,%=&.+/$39$-&)'&')$&'$(3$%<*(&6*+$1+D-&(+-$(3$#2+#A$:3<.$+%"&*$"##3<'(-B
8+($<6$!"&*$1&(2$"**$:3<.$"##3<'(-$-3$:3<$#"'$-++$"**$:3<.$%+--")+-$&'$3'+$6*"#+>$G233-+
!"&*$d$5//$5##3<'(>

L4*+%.7$%(497.%J$//"9$,%5-$:3<$(:6+$&'$(2+$-+".#2$9&+*/;$-<))+-(&3'-$93.$%+--")+-$(2"(
D+-($%"(#2$:3<.$@<+.:$"66+".$"($(2+$(36$39$(2+$-+".#2$.+-<*(->

Q+:'3(+$8<663.(

Draft Apple proprietary and confidential
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,-.'/010'2334150-63
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F++%$2$*./%"*+%5'*."5./%(497.%M('J%I"4&,%?2+'$:3<$.+#+&4+$"$%+--")+$(2"($&'#*</+-$"
'+1$+%"&*$"//.+--$3.$+4+'(;$e<-($#*&#A$5//$(3$"//$&($(3$G3'("#(-$3.$G"*+'/".>

X$(/'*"&4Q$%"*3%J$//"9$,%5//$+%3e&$3.$623(3-$1&(2$e<-($"$#*&#A>$8+*+#($623(3-$9.3%$:3<.
623(3$*&D.".:$3.$("A+$(2+%$3'$&O23'+$3.$&O"/>$73.$%3.+$"D3<($&'-+.(&')$623(3-$9.3%$3(2+.
/+4&#+-;$-++$ >

H4$R%4*%M)&&%/5($$*,%?2+'$:3<E.+$<-&')$!"&*$&'$9<**$-#.++';$1&'/31-$93.$'+1$%+--")+-
"<(3%"(&#"**:$36+'$&'$86*&($`&+1$3'$(2+$.&)2(;$-3$&(E-$+"-:$(3$.+9+.+'#+$"'3(2+.$%+--")+$&'
:3<.$&'D3C$"-$:3<$1.&(+>

G3'(&'<&(:$G"%+."

Draft Apple proprietary and confidential
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7-84'*F'9:'%$

W$2$(%J4//%"*%$J"4&,%G2+#A$(2+$!"&*$&#3'$&'$(2+$[3#A$(3$-++$"$#3<'($39$<'.+"/$+%"&*->
?2+'$:3<$)+($"$'+1$+%"&*;$"$'3(&9&#"(&3'$"*-3$"66+".-$"($(2+$(36S.&)2($39$(2+$-#.++'$-3
:3<$#"'$@<&#A*:$6.+4&+1$&'#3%&')$%+--")+->$H[3'E($1"'($'3(&9&#"(&3'-B$R3<$#"'$(<.'
(2+%$399g$G*&#A$(2+$8:-(+%$O.+9+.+'#+-$&#3'$ $&'$(2+$[3#A;$(2+'$#*&#A$V3(&9&#"(&3'->I

!41G%=3$@<&#A*:$/+*+(+$"$%+--")+$&'$:3<.$&'D3C;$-1&6+$*+9($3'$(2+$%+--")+$1&(2$3'+
9&')+.$3'$:3<.$!")&#$!3<-+$Y;$(2+'$#*&#A$[+*+(+>$F.$-1&6+$.&)2($(3$%".A$(2+$+%"&*$"-
0'.+"/>

V$"(*%J'($,%=3$*+".'$%3.+$"D3<($!"&*;$-++$(2+$ >

!":)

,+($/&.+#(&3'-$"'/$4&+1$*3#"(&3'-$<-&')$-("'/"./$3.$-"(+**&(+$&%")+.:>$F.$<-+$7*:34+.$(3
4&+1$-+*+#($#&(&+-$&'$X[>

!"&*$0-+.$,<&/+

Draft Apple proprietary and confidential
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,-.'/010'2334150-63

7-84'*G'9:'%$

V$.%4X7'*$%/7'R%3')%.7$%R"3,%G*&#A$[&.+#(&3'-$(3$9&'/$(2+$D+-($.3<(+$(3$:3<.$/+-(&'"(&3';
(2+'$#*&#A$(2+$82".+$D<((3'$ $(3$-+'/$(2+$/&.+#(&3'-$(3$:3<.$&O23'+$93.$(<.'SD:S(<.'$43&#+
'"4&)"(&3'>

-$.%.7$($%'*%1);&45%.("*/4.,%!"6-$6.34&/+-$6<D*&#$(."'-&($&'93.%"(&3'$93.$-+*+#($#&(&+->
G*&#A$=."'-&(;$(2+'$#*&#A$"$/+-(&'"(&3'$(3$)+($-<))+-(+/$(."4+*$.3<(+-$"'/$+-(&%"(+/$(."4+*
(&%+>

I'($%.7"*%Z)/.%J"1/,%73.$*3#"*$63&'(-$39$&'(+.+-($-<#2$"-$23(+*-$"'/$.+-("<."'(-;$!"6-
-231-$:3<$623'+$'<%D+.-;$623(3-;$"'/$+4+'$.+4&+1->

KFUWNW-G%73.$&%63.("'($&'93.%"(&3'$"D3<($'"4&)"(&3'$"'/$"43&/&')$/&-(."#(&3'-$(2"(
#3<*/$*+"/$(3$/"')+.3<-$-&(<"(&3'-;$-++$ >

!41G%=3$#2+#A$(."99&#;$#*&#A$(2+$8231$636S<6$%+'<$&'$(2+$D3((3%$*+9($39$(2+$%"6;$(2+'
#233-+$8231$=."99&#>

V$"(*%J'($,%=3$*+".'$%3.+$"D3<($!"6-;$-++$(2+$ >

J%63.("'($-"9+(:$&'93.%"(&3'

!"6-$0-+.$,<&/+

Draft Apple proprietary and confidential

https://support.apple.com/guide/maps/welcome
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7-84'**'9:'%$

!*))"2*)

J(E-$+"-:$(3$-(":$&'$(3<#2;$1&(2$!+--")+->$G3''+#($1&(2$3'+$3.$%3.+$6+36*+$(2.3<)2$(+C(;
"</&3;$3.$4&/+3>$5'/$&9$:3<$1"'($(3$-2".+$9&*+-;$:3<$#"'$/3$(2"($(33>$H_+@<&.+-$"'$+C(+.'"*
%&#.3623'+>$5##+--3.&+-$".+$-3*/$-+6"."(+*:$"($ $3.$:3<.$*3#"*$566*+$8(3.+>I

049*%4*%"*+%/$*+,%8&)'$&'$1&(2$:3<.$566*+$J[$(3$+C#2"')+$<'*&%&(+/$&!+--")+$(+C(-f
&'#*</&')$(+C(;$623(3-;$L&4+$O23(3-;$4&/+3;$"'/$%3.+f1&(2$"':3'+$1&(2$"$!"#;$&O23'+;
&O"/;$&O3/$(3<#2;$3.$566*+$?"(#2>

!41G%R3<$#"'$"*-3$-+'/$"'/$.+#+&4+$8!8$"'/$!!8$%+--")+-$3'$:3<.$!"#;$-3$9.3%
:3<.$!"#$:3<$#"'$(+C($9.&+'/-$123$2"4+$"'$&O23'+;$&9$:3<.$&O23'+$H1&(2$&F8$Z>T$3.$*"(+.I$&-
-&)'+/$&'$(3$!+--")+-$1&(2$(2+$-"%+$566*+$J[>$F'$:3<.$&O23'+;$)3$(3$8+((&')-$d
!+--")+-;$("6$=+C($!+--")+$73.1"./&');$(2+'$("6$(2+$'"%+$39$:3<.$!"#$(3$(<.'$3'$=+C(
!+--")+$73.1"./&')>$F'$:3<.$!"#;$:3<E**$-++$"'$"#(&4"(&3'$#3/+>$M'(+.$(2&-$3'$:3<.
&O23'+;$(2+'$("6$5**31>

I"#$%J$//"9$/%M)*,%L&4+'$<6$/&-#<--&3'-$D:$.+-63'/&')$(3$%+--")+-$1&(2$*".)+$+%3e&
3.$="6D"#A->$=3$"//$"$="6D"#A;$#*&#A$"'/$23*/$"$%+--")+;$(2+'$#233-+$"$="6D"#A>$5'/
*33A$3<($93.$-(&#A+.-;$[&)&("*$=3<#2;$&'4&-&D*+$&'A;$"'/$2"'/1.&((+'$%+--")+-$(2"($:3<.
9.&+'/-$-+'/$:3<$9.3%$(2+&.$&F8$/+4&#+$3.$566*+$?"(#2>

K7$*%"%.$_.%4/*\.%$*')97,%J9$:3<.$9.&+'/$2"-$7"#+=&%+;$:3<$#"'$-(".($"$7"#+=&%+$4&/+3$3.
"</&3$#2"($.&)2($9.3%$"$#3'4+.-"(&3'$&'$!+--")+->$j<-($#*&#A$[+("&*-$&'$(2+$%+--")+
1&'/31;$(2+'$#*&#A$(2+$`&/+3$D<((3'$ $3.$5</&3$D<((3'$ >

"66*+>#3%

Draft Apple proprietary and confidential
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07"($%3')(%/5($$*,%R3<$#"'$-2".+$:3<.$-#.++'$1&(2$"$9.&+'/f"'/$4&#+$4+.-"f"'/$+4+'
36+'$93*/+.-;$#.+"(+$/3#<%+'(-;$"'/$#36:$9&*+-$D:$/."))&')$(2+%$(3$(2+$/+-A(36$3'$(2+
-2".+/$-#.++'>$G*&#A$[+("&*-;$(2+'$#*&#A$(2+$8#.++'$82".+$D<((3'$ >

V$"(*%J'($,%=3$*+".'$%3.+$"D3<($!+--")+-;$-++$(2+$ >

B0+*)

V3(+-$".+$%3.+$(2"'$e<-($(+C(>$5//$"$#2+#A*&-(;$"'/$#2+#A$399$&(+%-$"-$:3<$#3%6*+(+
(2+%>$F.$"//$623(3-;$4&/+3-;$"'/$#3'(+'($9.3%$3(2+.$"66-;$-<#2$"-$1+D$*&'A-$9.3%$8"9".&
3.$"$*3#"(&3'$9.3%$!"6->

:7$5#%'MM%."/#/,%G*&#A$(2+$G2+#A*&-($D<((3'$ $(3$"//$"'$&'(+."#(&4+$#2+#A*&-($(3$"$'3(+f
6+.9+#($93.$#3%6*+(&')$"$(3S/3$*&-($3.$13.A&')$(2.3<)2$"$.+#&6+>

!+--")+-$0-+.$,<&/+

Draft Apple proprietary and confidential
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!41G%?2+'$:3<E.+$-&)'+/$&'$(3$&G*3</;$:3<.$'3(+-$".+$A+6($<6$(3$/"(+$3'$"**$:3<.
/+4&#+-f-3$:3<$#"'$#.+"(+$"$(3S/3$*&-($3'$:3<.$!"#;$(2+'$#2+#A$&(+%-$399$3'$:3<.$&O23'+
12&*+$:3<E.+$3'$(2+$)3>

F++%17'.'/`%24+$'/`%"*+%J'($,%G233-+$?&'/31$d$O23(3$a.31-+.$(3$"//$&(+%-$9.3%
:3<.$O23(3-$*&D.".:$(3$"$'3(+>$F.$/.")$"$623(3;$4&/+3;$O[7;$3.$3(2+.$/3#<%+'($9.3%$(2+
/+-A(36>

F++%"%.";&$,%G*&#A$(2+$="D*+$D<((3'$ $(3$"//$"$("D*+$(3$:3<.$'3(+>$R3<$#"'$+4+'$#36:$"
("D*+$9.3%$"$1+D-&(+$3.$"'3(2+.$"66$"'/$6"-(+$&($&'(3$:3<.$'3(+>

X).%"%14*%4*%4.,%=3$A++6$"$'3(+$"($(2+$(36$39$(2+$'3(+-$*&-(;$-1&6+$.&)2($3'$(2+$'3(+$&'$(2+
'3(+-$*&-($"'/$#*&#A$ >

07"($%"%*'.$,%R3<$#"'$&'4&(+$6+36*+$(3$4&+1$"'/$+/&($:3<.$'3(+-$D:$-2".&')$(2+%>$G*&#A
(2+$5//$O+36*+$D<((3'$ $"'/$-+*+#($"$%+(23/$93.$-+'/&')$(2+$*&'A>

V'5#%"%*'.$,%R3<$#"'$*3#A$"$'3(+$1&(2$"$6"--13./$(3$%"A+$-<.+$(2"($3'*:$(23-+$123$A'31
(2+$6"--13./$#"'$-++$(2+$'3(+>$=3$*3#A$"$'3(+$1&(2$"$6"--13./;$#233-+$V3(+-$d
O.+9+.+'#+-$"'/$#*&#A$8+($O"--13./>$=2+'$-+*+#($(2+$'3(+$:3<$1"'($(3$*3#A;$"'/$#233-+
7&*+$d$L3#A$=2&-$V3(+>

V$"(*%J'($,%=3$*+".'$%3.+$"D3<($V3(+-;$-++$(2+$ >

B5%>*6)

0-+$V<%D+.-$(3$#.+"(+$"((."#(&4+$"'/$631+.9<*$-6.+"/-2++(-$3'$:3<.$!"#>$!3.+$(2"'$XU
566*+S/+-&)'+/$(+%6*"(+-$)&4+$:3<$"$2+"/$-(".($#.+"(&')$D</)+(-;$&'43&#+-;$(+"%$.3-(+.-;
"'/$%3.+>$V<%D+.-$#"'$"*-3$36+'$"'/$+C63.($!&#.3-39($MC#+*$-6.+"/-2++(->

0."(.%R4.7%"%.$J1&".$^.7$*%"++%R7".%3')%R"*.,%8+*+#($(2+$-"%6*+$(+C($&'$(2+
(+%6*"(+;$(2+'$(:6+$'+1$(+C(>$=3$"//$&%")+-;$/.")$"$)."62&#$9&*+$9.3%$:3<.$!"#$3'(3$(2+
6*"#+23*/+.$&%")+>

V3(+-$0-+.$,<&/+

Draft Apple proprietary and confidential
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7-84'*%'9:'%$

-$.%'(9"*4Q$+%R4.7%/7$$./,%0-+$%<*(&6*+$-2++(-$3.$("D-$(3$-231$/&99+.+'($4&+1-$39$:3<.
&'93.%"(&3'>$73.$+C"%6*+;$<-+$3'+$-2++($93.$:3<.$D</)+(;$"'3(2+.$93.$"$("D*+;$"'/$"$(2&./
93.$'3(+->$G*&#A$ $(3$"//$"$'+1$-2++(>$[.")$"$("D$*+9($3.$.&)2($(3$.+3./+.$-2++(->

L'(J)&"/%"($%"%/*"1,%,+($D<&*(S&'$2+*6$93.$%3.+$(2"'$Y\U$631+.9<*$9<'#(&3'-fe<-($(:6+
(2+$+@<"*$-&)'$HrI$&'$"$#+**;$"'/$:3<$-++$"$*&-($39$"**$(2+$9<'#(&3'-$"'/$(2+&.$/+-#.&6(&3'-$&'
(2+$-&/+D".>$8(".($(:6&')$"$93.%<*"$(3$)+($&'-("'($-<))+-(&3'->

!41G%=3$)+($&'-("'($#"*#<*"(&3'-$3'$"$-+.&+-$39$4"*<+-;$-+*+#($(2+$."')+$39$#+**-
#3'("&'&')$(2+$4"*<+-;$(2+'$*33A$/31'$"($(2+$D3((3%$39$(2+$1&'/31>$R3<E**$-++$(2+$-<%;
"4+.")+;$%&'&%<%;$%"C&%<%;$"'/$#3<'($39$(2+$-+*+#(+/$4"*<+->$G*&#A$(2+$8+((&')-$D<((3'$
$(3$-++$+4+'$%3.+$36(&3'->

V$"(*%J'($,%=3$*+".'$%3.+$"D3<($V<%D+.-;$-++$ >

D"2*)

0-+$(2+$O")+-$"66$(3$#.+"(+$-(<''&')$%+/&"S.&#2$/3#<%+'(-$3'$:3<.$!"#>$F6+'$"'/$+/&(
!&#.3-39($?3./$9&*+-;$"'/$+"-&*:$-2".+$"$*&'A$(3$:3<.$13.A$1&(2$!"&*$3.$!+--")+-;$.&)2(
9.3%$(2+$(33*D".>

V''#%9''+a%O")+-$&'#*</+-$"$4".&+(:$39$D+"<(&9<*$(+%6*"(+-$93.$9*:+.-;$'+1-*+((+.-;
.+63.(-;$"'/$.s-<%s-;$"%3')$3(2+.-;$%"A&')$&($+"-:$(3$-(".($:3<.$6.3e+#(>

V<%D+.-$8<663.(

Draft Apple proprietary and confidential
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Mac mini Essentials

Page 59 of 81

All your formatting tools, in one place. Click the Format button  in the toolbar to
open the Format inspector. Select something in your document, and the formatting
options for it appear.

Flow text around graphics. When you add an image to a text document, the text flows
automatically around the image. You can fine-tune how the text wraps in the Format
sidebar.

Start on your Mac, finish on iPad. You can keep documents up to date across all your
devices when you sign in to iCloud with the same Apple ID. So you can start composing
on one device, and pick up where you left off on another.

Tip: Turn on change tracking to see the changes you and others make to a document.
Each personʼs edits and comments are color-coded, so you can see who made the
change. Choose Edit > Turn on Tracking to show the change tracking toolbar.

Learn more. To learn more about Pages, see .Pages Support

Draft Apple proprietary and confidential
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D/0+0)

0-+$O23(3-$"'/$&G*3</$O23(3-$(3$3.)"'&N+;$+/&(;$"'/$-2".+$:3<.$623(3-$"'/$4&/+3-;$"'/
A++6$:3<.$+'(&.+$623(3$*&D.".:$<6$(3$/"(+$3'$"**$:3<.$/+4&#+->$?&(2$O23(3-;$&(E-$+"-:$(3
3.)"'&N+$"*D<%-;$9&'/$e<-($(2+$623(3$(2"($:3<E.+$*33A&')$93.;$"'/$%"A+$D+"<(&9<*
-*&/+-231-$"'/$623(3$)&9(->

-$.%'(9"*4Q$+,%=2+$(33*D".$&'$O23(3-$'31$*+(-$:3<$"##+--$"**$O23(3-;$!3%+'(-;
G3**+#(&3'-;$3.$R+".-$1&(2$3'+$#*&#A;$"'/$:3<$#"'$#<-(3%&N+$(2+$-&/+D".$D:$/."))&')$"'/
/.366&')$-+#(&3'-$"'/$"*D<%->$8+*+#($%<*(&6*+$623(3-$"($3'#+$"'/$#*&#A$ $(3$D"(#2$.3("(+
(2+%;$%".A$(2+%$"**$"-$7"43.&(+-$D:$#*&#A&')$ ;$3.$<-+$(2+$-+*+#(&3'$#3<'(+.$(3$/.")$"'/
/.36$(2+$-+*+#(+/$623(3-$&'(3$"$'+1$"*D<%>

U$&42$%J$"*4*9M)&%J'J$*./,%G*&#A$!+%3.&+-$(3$-++$9"43.&(+$"'/$93.)3((+'$3##"-&3'-
9.3%$:3<.$623(3$*&D.".:>$!+%3.&+-$"<(3%"(&#"**:$#.+"(+-$623(3$#3**+#(&3'-$9.3%$+4+'(-;
*&A+$"$1+//&')$3.$9"%&*:$4"#"(&3';$3.$9.3%$(2+%+-;$*&A+$6+(-$"'/$D"D&+->

X$'1&$%"*+%X&"5$/,%=2+$O+36*+$9+"(<.+$"<(3%"(&#"**:$3.)"'&N+-$:3<.$623(3$*&D.".:$D:
6+36*+$&'$:3<.$623(3-;$D"-+/$3'$231$39(+'$+"#2$6+.-3'$"66+".-$&'$:3<.$*&D.".:>$!"A+
-3%+3'+$"$9"43.&(+$D:$#*&#A&')$(2+$7"43.&(+$D<((3'$ $(2"($"66+".-$3'$(2+&.$623(3;$"'/
(2+:E**$"*1":-$"66+".$"($(2+$(36$39$(2+$"*D<%>$0-+$(2+$O*"#+-$"*D<%$(3$4&+1$"**$:3<.
623(3-$1&(2$*3#"(&3'$/"("$3'$"'$&'(+."#(&4+$%"6>$t33%$&'$3'$(2+$%"6$(3$.+4+"*$%3.+
623(3-$9.3%$"$-6+#&9&#$*3#"(&3'>

!41G%R3<$#"'$"//$*3#"(&3'$&'93$(3$"':$623(3>$?2&*+$4&+1&')$(2+$623(3;$#*&#A$(2+$J'93
D<((3'$ ;$#*&#A$5--&)'$"$L3#"(&3';$(2+'$-(".($(:6&')>$G233-+$:3<.$*3#"(&3'$9.3%$(2+$*&-(;$3.
(:6+$&($"'/$(2+'$6.+--$_+(<.'>
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L4*+%.7$%1$(M$5.%/7'.,%8+".#2$:3<.$623(3-$D"-+/$3'$12"(E-$&'$(2+%;$(2+$/"(+$(2+:$1+.+
("A+';$6+36*+$:3<E4+$'"%+/$&'$(2+%;$"'/$(2+&.$*3#"(&3'$&9$6.34&/+/>$O23(3-$&/+'(&9&+-
3De+#(-;$-#+'+-;$"'/$6+36*+;$-3$:3<$/3'E($2"4+$(3$<-+$A+:13./-$(3$(")$+"#2$623(3>

Y+4.%&4#$%*$2$(%;$M'($,%0-+$+/&(&')$(33*-$(3$"/e<-($*&)2($"'/$#3*3.;$"66*:$9&*(+.-;$#.36;
.+(3<#2;$"'/$%3.+;$"**$+"-&*:$"##+--&D*+$D:$#*&#A&')$M/&($12&*+$4&+1&')$"':$623(3>$73.$%3.+
"/4"'#+/$+/&(&');$(.:$(2+$L+4+*-$(33*$(3$"/e<-($2&)2*&)2(-$"'/$-2"/31-;$3.$G<.4+-$(3$%"A+
9&'+S(<'+/$#3'(."-($"/e<-(%+'(->$5-$:3<$%"A+$#2"')+-;$#*&#A$(2+$G3%6".+$D<((3'$ $(3
@<&#A*:$(3))*+$D+(1++'$(2+$<'+/&(+/$"'/$+/&(+/$4+.-&3'->$R3<$#"'$<-+$-3%+$(2&./S6".(:
"66-$/&.+#(*:$1&(2&'$O23(3-;$12&#2$%"A+-$&($+4+'$+"-&+.$(3$13.A$3'$:3<.$623(3S.+*"(+/
6.3e+#(->

-$.%&42$&3,%?&(2$L&4+$O23(3-;$<-+$(2+$'+1$L336$+99+#($(3$#3'(&'<3<-*:$*336$(2+$"#(&3';$3.
<-+$a3<'#+$(3$6*":$(2+$"'&%"(&3'$93.1"./$"'/$D"#A1"./>$R3<$#"'$"*-3$<-+$L3')$MC63-<.+
(3$D*<.$%3(&3'$&'$:3<.$L&4+$O23(3->

V$"(*%J'($,%=3$*+".'$%3.+$"D3<($O23(3-;$-++$(2+$ >

-"C"6&

8"9".&$&-$(2+$9"-(+-($"'/$%3-($+99&#&+'($1":$(3$-<.9$(2+$1+D$3'$:3<.$!"#>

0."(.%/$"(574*9,%G*&#A$(2+$8%".($8+".#2$9&+*/$"($(2+$(36$39$(2+$1&'/31$(3$-++$1+D-&(+-
:3<E4+$"//+/$"-$9"43.&(+->$F.$-(".($(:6&')$"$13./$3.$1+D-&(+$"//.+--f8"9".&$-231-$:3<
%"(#2&')$1+D-&(+-;$"-$1+**$"-$8"9".&$8<))+-(&3'-$9.3%$(2+$J'(+.'+(;$&=<'+-;$(2+$566
8(3.+;$%34&+$-231(&%+-;$'+".D:$*3#"(&3'-;$"'/$%3.+>

O23(3-$0-+.$,<&/+
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View multiple websites in one window. Click  at the far right of the tab bar or press
Command-T to open a new tab, then enter an address. To keep a website handy, drag its
tab left to pin it, and it stays in the tab bar.

See whatʼs open on all your devices. You can see open webpages on all your devices
that are signed in to the same iCloud account. Just click the Show All Tabs button  at
the top of the window and scroll down if necessary.

Browse the web safely and privately. Safari warns you when you visit a website thatʼs
not secure, or that may be trying to trick you into sharing your personal data. Safari also
protects you automatically from cross-site tracking, by identifying and removing the data
that trackers leave behind. Safari asks your permission before allowing a social network
to see what youʼre doing on third-party sites. For example, if you click a Facebook button
to share an article to Facebook, Safari asks if you want to let Facebook see your activity
on the site. And Safari defends you against web tracking by making your Mac harder to
identify uniquely.

When you sign up for a new account on the web, Safari automatically creates and
autofills a new strong password for you. If you choose Use Strong Password, the
password is saved to your iCloud Keychain and will autofill on all the devices you log in to
with the same iCloud account. You can ask Siri to show you your saved passwords, which
you can see after entering the authentication password for your Mac, or go to Safari >
Preferences and then click Passwords. Reused passwords are flagged in the passwords
list, so you can easily replace them with strong passwords.

Draft Apple proprietary and confidential
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N")$+&8&.&$%":$'3($D+$"4"&*"D*+$&'$"**$*"')<")+-$3.$&'$"**$".+"-;$"'/$9+"(<.+-$%":$4".:$D:
".+">

0$.%)1%1($M$($*5$/%M'(%3')(%M"2'(4.$%/4.$/,%J9$:3<$39(+'$"/e<-($-+((&')-$93.$#+.("&'
1+D-&(+-;$:3<$#"'$<-+$8"9".&$6.+9+.+'#+-$(3$-"4+$(23-+$-+((&')->$R3<$#"'$(<.'$3'$:3<.
#3'(+'($D*3#A+.;$+'"D*+$_+"/+.$%3/+;$"**31$'3(&9&#"(&3'-;$-+($"$-6+#&9&#$6")+$N33%;$"'/
%3.+fe<-($93.$(2+$1+D-&(+-$:3<$#233-+>$?2+'$:3<E.+$4&-&(&')$"$1+D-&(+;$#233-+$8"9".&$d
8+((&')-$93.$=2&-$?+D-&(+;$3.$-+#3'/".:$#*&#A$H(2"($&-;$.&)2(S#*&#AI$3'$(2+$0_L$&'$(2+$8%".(
8+".#2$9&+*/>

07'1%R4.7%F11&$%X"3,%?2+'$:3<E.+$-2366&')$3'*&'+$3'$"$-<663.(+/$1+D-&(+;$#*&#A$(2+
566*+$O":$D<((3'$(3$%"A+$"$6<.#2"-+>$=3$#3%6*+(+$(2+$(."'-"#(&3';$<-+$=3<#2$J[$3.$(2+
6"--#3/+$3'$:3<.$&O23'+;$3.$/3<D*+S#*&#A$(2+$-&/+$D<((3'$3'$:3<.$<'*3#A+/$566*+$?"(#2>

V$"(*%J'($,%=3$*+".'$%3.+$"D3<($8"9".&;$-++$(2+$ >

-+0#4)

=2+$8(3#A-$"66$&-$(2+$D+-($1":$(3$(."#A$(2+$%".A+($3'$:3<.$!"#>$`&+1$6.&#+-$&'$(2+
#<-(3%$1"(#2*&-(;$#*&#A$"$-(3#A$(3$-++$%3.+$/+("&*-$"'/$"'$&'(+."#(&4+$#2".(;$"'/$.+"/
"D3<($12"(E-$/.&4&')$(2+$%".A+(;$1&(2$-(3.&+-$9.3%$566*+$V+1->

8"9".&$0-+.$,<&/+
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N")$+&566*+$V+1-$-(3.&+-$"'/$=36$8(3.&+-$".+$"4"&*"D*+$&'$(2+$0>8>;$0Q;$"'/$5<-(."*&">
V+1-$-(3.&+-$&'$3(2+.$#3<'(.&+-$".+$6.34&/+/$D:$R"233>

:)/.'J4Q$%3')(%R".57&4/.,%G*&#A$(2+$+/&($D<((3'$"($(2+$D3((3%$39$(2+$*&-($(3$#<-(3%&N+
-(3#A-;$&'/+C+-;$#<..+'#&+-;$"'/$%3.+>$?2&*+$4&+1&')$:3<.$1"(#2*&-(;$#*&#A$(2+$).++'$3.
.+/$D<((3'$D+*31$+"#2$6.&#+$(3$#:#*+$D+(1++'$6.&#+$#2"')+;$6+.#+'(")+$#2"')+;$"'/
%".A+($#"6&("*&N"(&3'>$=2+$1"(#2*&-($"*-3$&'#*</+-$#3*3.S#3/+/$-6".A*&'+-$(2"($(."#A
6+.93.%"'#+$(2.3<)23<($(2+$/":>

U$"+%"(.45&$/%($&".$+%.'%.7$%5'J1"*4$/%3')%M'&&'R,%G*&#A$"$-(3#A$&'$:3<.$1"(#2*&-($(3
-++$"'$&'(+."#(&4+$#2".($"'/$"//&(&3'"*$/+("&*-;$"'/$.+"/$(2+$*"(+-($'+1-$"D3<($(2"(
#3%6"':>

-$.%"%+$$1$(%24$R,%?"'($(3$-++$12"($(2+$%".A+($1"-$/3&')$*"-($1++A;$*"-($%3'(2;$3.$*"-(
:+".B$G*&#A$(2+$D<((3'-$"D34+$(2+$#2".($(3$-1&(#2$(&%+9."%+-$"'/$-++$6.&#+-$&'$(2+$4&+1
:3<$*&A+$D+-(>

b')(%R".57&4/.%'*%"&&%'M%3')(%+$245$/,%Q++6$:3<.$1"(#2*&-($#3'-&-(+'($"#.3--$"**$:3<.
/+4&#+-$12+'$:3<$-&)'$&'$(3$&G*3</$1&(2$(2+$-"%+$566*+$J[>

V$"(*%J'($,%=3$*+".'$%3.+$"D3<($8(3#A-;$-++$(2+$ >

!41G%G*&#A$(2+$=36$8(3.&+-$-+#(&3'$&'$(2+$1"(#2*&-($(3$-++$"$#3**+#(&3'$39$(&%+*:
D<-&'+--$".(&#*+-;$#<."(+/$D:$566*+$V+1-$+/&(3.->

8(3#A-$0-+.$,<&/+
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N0&#*$!*%0)

`3&#+$!+%3-$%"A+-$&($+"-&+.$(2"'$+4+.$(3$#"6(<.+$6+.-3'"*$.+%&'/+.-;$#*"--$*+#(<.+-;$"'/
+4+'$&'(+.4&+1-$3.$-3')$&/+"->$?&(2$&G*3</;$:3<$#"'$"##+--$(2+$43&#+$%+%3-$:3<$.+#3./
1&(2$:3<.$&O23'+;$.&)2($3'$:3<.$!"#$%&'&>

U$5'(+%M('J%3')(%I"5%J4*4,%=3$.+#3./;$#*&#A$(2+$.+/$D<((3'>$=3$-(36$.+#3./&');$#*&#A
[3'+>$V"%+$:3<.$.+#3./&')-$(3$A++6$(2+%$3.)"'&N+/$D:$(:6&')$&'$(2+$'"%+$9&+*/>$O*":
D"#A$:3<.$.+#3./&')$D:$#*&#A&')$(2+$6*":$D<((3'>

b')(%2'45$%J$J'/%"5('//%"&&%3')(%+$245$/,%R3<.$43&#+$%+%3-$".+$"4"&*"D*+$3'$"**$39
:3<.$/+4&#+-$12+'$:3<$-&)'$&'$(3$&G*3</$1&(2$(2+$-"%+$566*+$J[>$R3<$#"'$"##+--
.+#3./&')-$:3<$%"/+$1&(2$:3<.$&O23'+$3.$&O"/$.&)2($9.3%$:3<.$!"#>

V$"(*%J'($,%=3$*+".'$%3.+$"D3<($`3&#+$!+%3-;$-++$(2+$ >`3&#+$!+%3-$0-+.$,<&/+
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%"#G-$J)*6$;5&9*

=2+$%"#F8$0-+.$,<&/+$2"-$"$*3($%3.+$&'93.%"(&3'$"D3<($231$(3$<-+$:3<.$!"#$%&'&>

-$.%7$&1,%G*&#A$(2+$7&'/+.$&#3'$ $&'$(2+$[3#A;$(2+'$#*&#A$(2+$K+*6$%+'<$&'$(2+$%+'<$D".
"'/$#233-+$%"#F8$K+*6$(3$36+'$(2+$%"#F8$0-+.$,<&/+>$F.$(:6+$"$@<+-(&3'$3.$(+.%$&'
(2+$-+".#2$9&+*/;$(2+'$#233-+$"$(36&#$9.3%$(2+$.+-<*(-$*&-(>

Y_1&'($%.'145/,%=3$9&'/$"$(36&#$&'$(2+$%"#F8$0-+.$,<&/+;$:3<$#"'$D.31-+$3.$-+".#2>$=3
D.31-+;$#*&#A$h="D*+$39$G3'(+'(-i$(3$-++$(2+$*&-($39$(36&#-;$(2+'$#*&#A$"$(36&#$(3$.+"/$&(>$F.
(:6+$12"($:3<$1"'($(3$9&'/$&'$(2+$-+".#2$9&+*/$(3$)3$.&)2($(3$:3<.$"'-1+.>

<&'9$"')1*6)
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L4*+%').%R7".\/%*$R,%G*&#A$(2+$K+*6$%+'<;$(2+'$#233-+$?2"(E-$V+1$&'$%"#F8$(3$9&'/
3<($%3.+$"D3<($(2+$*"(+-($9+"(<.+-$39$%"#F8>

!41G%J9$:3<$#"'E($.+%+%D+.$(2+$*3#"(&3'$39$"$%+'<$&(+%$&'$"'$"66;$-+".#2$93.$&($&'$K+*6>
O*"#+$(2+$63&'(+.$34+.$(2+$.+-<*(;$"'/$"'$"..31$-231-$:3<$(2+$#3%%"'/>

70%%0'$O5*)+&0')

P'R%+'%N%9$.%/)11'(.%M'(%J3%I"5%J4*4]%,3$(3$ >

K7$($\/%J3%/$(4"&%*)J;$(]%G233-+$566*+$%+'<$c$d$5D3<($=2&-$!"#>$=2+$-+.&"*
'<%D+.$&-$(2+$*"-($&(+%$&'$(2+$*&-(>$R3<$#"'$9&'/$(2+$-+.&"*$'<%D+.$3'$(2+$D3((3%$39
!"#$%&'&>$8++$(2+$566*+$8<663.($".(&#*+$ >

P'R%+'%N%9$.%7$&1%M'(%"*%"11]%?2+'$:3<E.+$<-&')$(2+$"66;$#*&#A$(2+$K+*6$%+'<$&'$(2+
%+'<$D".$"($(2+$(36$39$(2+$-#.++'>

K7$($%4/%.7$%/"M$.3%4*M'(J".4'*%M'(%J3%I"5%J4*4]%8++$ >

P'R%+'%N%M4*+%.7$%.$57*45"&%/1$54M45".4'*/]%,3$(3$ ;$3.$#233-+
566*+$%+'<$c$d$5D3<($=2&-$!"#$"'/$#*&#A$(2+$D<((3'-$"($(2+$(36>

!"#$%&'&$-<663.(

!"#$%&'&g$K31$(3$9&'/$(2+$-+.&"*$'<%D+.

J%63.("'($-"9+(:$&'93.%"(&3'

!"#$%&'&$-6+#-
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How do I check my disk for problems? Use Disk Utility. See the Apple Support article
.

Keyboard shortcuts

You can press key combinations to do things on your Mac mini that youʼd normally do
with a trackpad, mouse, or other device. Hereʼs a list of commonly used keyboard
shortcuts.

Using Disk Utility to verify or repair disks
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Shortcut Description

Command-X Cut the selected item and copy it to the Clipboard.

Command-C Copy the selected item to the Clipboard.

Command-V Paste the contents of the Clipboard into the current document or
app.

Command-Z Undo the previous command. Press Command-Shift-Z to redo.

Command-A Select all items.

Command-F Open a Find window, or find items in a document.

Command-G Find the next occurrence of the item youʼre searching for. Press
Command-Shift-G to find the previous occurrence.

Command-H Hide the windows of the front app. Press Command-Option-H to
view the front app but hide all other apps.

Command-M Minimize the front window to the Dock. Press Command-Option-
M to minimize all windows of the front app.

Command-N Open a new document or window.

Command-O Open the selected item, or open a dialog to select a file to open.

Command-P Print the current document.

Command-S Save the current document.

Command-W Close the front window. Press Command-Option-W to close all
windows of the app.

Command-Q Quit the current app.

Command-Option-Esc Choose an app to force quit.

Command-Tab Switch to the next most recently used app among your open
apps.

Command-Shift-5 Open the Screenshot app and then:

Press Command-Shift-3 to take a screenshot of the entire
screen.

Press Command-Shift-4 to take a screenshot of a selected
area of the screen.
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If you switched to the Mac from a PC, go to  for a list of
Mac keyboard shortcuts and the differences between Mac and Windows keyboards. For a
more complete list of keyboard shortcuts, see the Apple Support article 

.

More resources, service, and support

You can find more information about your in System Report, Apple Diagnostics, and
through online resources.

System Report. To get information about your , use System Report. It shows you what
hardware and software is installed, the serial number and operating system version, how
much memory is installed, and more. To open System Report, choose Apple menu  >
About This Mac, then click System Report.

Apple Diagnostics. You can use Apple Diagnostics to help determine if thereʼs a problem
with one of the computerʼs components, such as the memory or processor. Apple
Diagnostics helps to identify the potential source of a hardware issue and provides first
steps to try and resolve it. Apple Diagnostics will also help you get in touch with
Apple Support if you need more help.

Before using Apple Diagnostics, disconnect any external devices, such as a hard disk or
external display. Be sure your is connected to the Internet.

To start Apple Diagnostics, restart your and hold down the D key as it starts up. If
prompted, select the language for your location. Press the Return key or click the right
arrow button. The basic Apple Diagnostics test takes a few minutes to complete. If issues
are found, a description of the issue appears with additional instructions. Make a note of
any reference codes before you exit Apple Diagnostics.

Online resources. For online service and support information, go to 
. You can learn about Apple products, view online manuals, and check for

software updates. Connect with other Apple users, and get service, support, and
professional advice from Apple.

AppleCare support. If you need assistance, AppleCare representatives can help you
with installing and opening apps, and with troubleshooting. Call the support center
number nearest you (the first 90 days are complimentary). Have the purchase date and
your serial number ready when you call.

Mac tips for Windows switchers

Mac keyboard
shortcuts

Welcome to
Apple Support
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A complete list of support telephone numbers is available on the web at 
. Telephone numbers are subject to change, and local and national

telephone rates may apply.

Your 90 days of complimentary telephone support begins on the date of purchase.

Contact Apple
for support and service
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KFUWNW-G%7"&*<.+$(3$93**31$(2+-+$-"9+(:$&'-(.<#(&3'-$#3<*/$.+-<*($&'$9&.+;$+*+#(.&#
-23#A;$3.$3(2+.$&'e<.&+-;$3.$/"%")+$(3$:3<.$!"#$%&'&$3.$3(2+.$6.36+.(:>$_+"/$"**$-"9+(:
&'93.%"(&3'$D+*31$D+93.+$<-&')$:3<.$!"#$%&'&>

P"*+&4*9,%8+($<6$:3<.$!"#$%&'&$3'$"$2"./;$-("D*+$13.A$-<.9"#+$(2"($"**31-$93.$"/+@<"(+
"&.$#&.#<*"(&3'$<'/+.$"'/$".3<'/$(2+$#3%6<(+.>$V+4+.$6<-2$3De+#(-$&'(3$(2+$4+'(&*"(&3'
36+'&')->$R3<.$!"#$%&'&$#"'$D+$/"%")+/$&9$/.366+/;$D<.'+/;$6<'#(<.+/;$3.$#.<-2+/;$3.
&9$&($#3%+-$&'$#3'("#($1&(2$*&@<&/-;$3&*-;$"'/$*3(&3'->$[3'E($<-+$"$/"%")+/$!"#$%&'&;$-<#2
"-$3'+$1&(2$"$#."#A+/$-#.++';$"-$&($%":$#"<-+$&'e<.:>

V4c)4+%$_1'/)($,%Q++6$:3<.$!"#$%&'&$"1":$9.3%$-3<.#+-$39$*&@<&/;$-<#2$"-$/.&'A-;$3&*-;
*3(&3'-;$1"-2D"-&'-;$D"(2(<D-;$-231+.$-("**-;$"'/$-3$3'>$O.3(+#($:3<.$!"#$%&'&$9.3%
/"%6'+--;$2<%&/&(:;$3.$1+($1+"(2+.;$-<#2$"-$."&';$-'31;$"'/$93)>

X'R$(,%0'6*<)$(2+$631+.$#3./$HD:$6<**&')$(2+$6*<);$'3($(2+$#3./I$"'/$/&-#3''+#($"**
#"D*+-$&9$"':$39$(2+$93**31&')$#3'/&(&3'-$+C&-(g

=2+$631+.$#3./$3.$6*<)$D+#3%+-$9.":+/$3.$3(2+.1&-+$/"%")+/>

R3<$-6&**$-3%+(2&')$&'(3$(2+$#"-+>

R3<.$!"#$%&'&$&-$+C63-+/$(3$."&'$3.$+C#+--$%3&-(<.+>

R3<.$!"#$%&'&$2"-$D++'$/.366+/;$3.$(2+$#"-+$2"-$D++'$/"%")+/>

R3<$-<-6+#($(2"($:3<.$!"#$%&'&$'++/-$-+.4&#+$3.$.+6"&.>

R3<$1"'($(3$#*+"'$(2+$#"-+$H<-+$3'*:$(2+$.+#3%%+'/+/$6.3#+/<.+;$/+-#.&D+/$*"(+.$&'
(2&-$/3#<%+'(I>

NJ1'(."*.G%=2+$3'*:$1":$(3$(<.'$399$631+.$#3%6*+(+*:$&-$(3$<'6*<)$(2+$631+.$#3./>$!"A+
-<.+$"($*+"-($3'+$+'/$39$(2+$631+.$#3./$&-$1&(2&'$+"-:$.+"#2$-3$(2"($:3<$#"'$<'6*<)$:3<.
!"#$%&'&$12+'$:3<$'++/$(3>

O31+.$-6+#&9&#"(&3'-g

U">)0/$+&TUU$(3$Y^U$`$5G

-"C*+.=$/"'9,&'2=$"'9$6*25,"+06.$&'C06%"+&0'
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C(%%$*)+&Y$5;$%"C&%<%
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Repetitive motion. When you perform repetitive activities such as typing or playing
games on Mac mini, you may experience discomfort in your hands, arms, wrists,
shoulders, neck, or other parts of your body. If you experience discomfort, stop using
Mac mini and consult a physician.

High-consequence activities. Mac mini is not intended for use where the failure of the
computer could lead to death, personal injury, or severe environmental damage.

Explosive and other atmospheric conditions. Using Mac mini in any area with a
potentially explosive atmosphere may be hazardous—particularly in areas where the air
contains high levels of flammable chemicals, vapors, or particles such as grain, dust, or
metal powders. Exposing Mac mini to environments having high concentrations of
industrial chemicals, including near evaporating liquified gasses such as helium, may
damage or impair Mac mini functionality. Obey all signs and instructions.

Important handling information

Operating environment. Operating your Mac mini outside these ranges may affect
performance:

Operating temperature: 50° to 95° F (10° to 35° C)

Storage temperature: -4° to 113° F (-25° to 45° C)

Relative humidity: 5% to 90% (noncondensing)

Operating altitude: Tested up to 16,404 feet (0 to 5000 meters)

Do not operate your Mac mini in areas with significant amounts of airborne dust, or
smoke from cigarettes, cigars, ashtrays, stoves, or fireplaces, or near an ultrasonic
humidifier using unfiltered tap water. Tiny airborne particles produced by smoking,
cooking, burning, or using an ultrasonic humidifier with unfiltered water may, in rare
instances, enter the ventilation openings of your Mac mini and, under certain conditions,
result in a slight haze on the inside surface of the glass panel that covers the Mac mini
display.

Carrying your Mac mini. Before you lift or reposition your Mac mini, shut it down and
disconnect all cables and cords. To lift your Mac mini, hold its sides.

Using connectors and ports. Never force a connector into a port. When connecting a
device, make sure the port is free of debris, that the connector matches the port, and
that you have positioned the connector correctly in relation to the port.
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Storing your Mac mini. If you are going to store your Mac mini for an extended period of
time, keep it in a cool location (ideally, 71° F or 22° C).

Cleaning your Mac mini. When cleaning the outside of your Mac mini and its
components, first shut down your Mac mini, then unplug all cords and cables. Then
dampen a clean, soft, lint-free cloth to wipe the Mac mini exterior. Avoid getting moisture
in any openings. Donʼt spray liquid directly on the computer. Donʼt use aerosol sprays,
solvents, abrasives, or cleaners containing hydrogen peroxide that might damage the
finish.

Cleaning the display. To clean the display, first shut down your Mac mini, then unplug all
cords and cables. Follow the cleaning instructions that came with the display.

Accessories such as Magic Mouse 2, Magic Trackpad 2, Magic Keyboard, and displays
are sold separately at  or your local Apple Store.

Understanding ergonomics

When you use the keyboard and mouse, your shoulders should be relaxed. Your upper
arm and forearm should form an angle that is slightly greater than a right angle, with your
wrist and hand in roughly a straight line.

Change hand positions often to avoid fatigue. Some computer users might develop
discomfort in their hands, wrists, or arms after intensive work without breaks. If you begin
to develop chronic pain or discomfort in your hands, wrists, or arms, consult a qualified
health specialist.

Mouse or optional trackpad. Position the mouse or trackpad at the same height as the
keyboard and within a comfortable reach.

apple.com
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Chair. An adjustable chair that provides firm, comfortable support is best. Adjust the
height of the chair so your thighs are horizontal and your feet are flat on the floor. The
back of the chair should support your lower back (lumbar region). Follow the
manufacturerʼs instructions for adjusting the backrest to fit your body properly.

Display. Arrange the display so that the top of the screen is slightly below eye level when
youʼre sitting at the keyboard. The best distance from your eyes to the screen is up to
you, although most people seem to prefer 18 to 28 inches (45 to 70 cm).

Position the display to minimize glare and reflections from overhead lights and windows.
The stand lets you set the display at the best angle for viewing, helping to reduce or
eliminate glare from lighting sources you canʼt move.

For more information about ergonomics, go to .

Regulatory information

Regulatory information, certification, and compliance marks specific to Mac mini are
available on-device. Choose Apple menu  > About This Mac > Support > Regulatory
Certification.

FCC regulatory compliance

This device complies with part 15 of the FCC Rules. Operation is subject to the following
two conditions: (1) This device may not cause harmful interference, and (2) this device
must accept any interference received, including interference that may cause undesired
operation.

Note: This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses, and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the
user is encouraged to try to correct the interference by one or more of the following
measures:

Reorient or relocate the receiving antenna.

Ergonomics
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Increase the separation between the equipment and receiver.

Connect the equipment to an outlet on a circuit different from that to which the
receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.

Important: Changes or modifications to this product not authorized by Apple could void
the electromagnetic compatibility (EMC) and wireless compliance and negate your
authority to operate the product.

This product has demonstrated EMC compliance under conditions that included the use
of compliant peripheral devices and shielded cables (including Ethernet network cables)
between system components. It is important that you use compliant peripheral devices
and shielded cables between system components to reduce the possibility of causing
interference to radios, television sets, and other electronic devices.

If necessary, contact Apple or take your Mac mini to an Apple-authorized repair center,
such as an Apple Authorized Service Provider. Or consult an experienced radio/television
technician for additional suggestions.

Exposure to radio frequency energy

The radiated output power of this device meets the limits of FCC/IC radio frequency
exposure limits. This device should be operated with a minimum separation distance of
20 cm (8 inches) between the equipment and a personʼs body.

Responsible party (contact for FCC matters only):
Apple Inc.

One Apple Park Way, MS 911-AHW
Cupertino, CA 95014
USA

ISED Canada regulatory compliance

This device complies with Innovation, Science and Economic Development Canada
license-exempt RSS standard(s). Operation is subject to the following two conditions: (1)
this device may not cause interference, and (2) this device must accept any interference,
including interference that may cause undesired operation of the device.

Operation in the band 5150–5250 MHz is only for indoor use to reduce the potential for
harmful interference to co-channel mobile satellite systems.

www.apple.com/contact
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Exposure to radio frequency energy

The radiated output power of this device meets the limits of FCC/IC radio frequency
exposure limits. This device should be operated with a minimum separation distance of
20 cm (8 inches) between the equipment and a personʼs body.

Le présent appareil est conforme aux CNR dʼInnovation, Sciences et Développement
économique Canada applicables aux appareils radio exempts de licence. Lʼexploitation
est autorisée aux deux conditions suivantes : (1) lʼappareil ne doit pas produire de
brouillage, et (2) lʼutilisateur de lʼappareil doit accepter tout brouillage radioélectrique
subi, même si le brouillage est susceptible dʼen compromettre le fonctionnement.

La bande 5150–5250 MHz est réservée uniquement pour une utilisation à lʼintérieur afin
de réduire les risques de brouillage préjudiciable aux systèmes de satellites mobiles
utilisant les mêmes canaux.

L̓ exposition à lʼénergie radiofréquence

La puissance de sortie rayonné de cet appareil est conforme aux limites de la FCC/IC
limites dʼexposition aux fréquences radio. Cet appareil doit être utilisé avec une distance
minimale de séparation de 20 cm entre lʼappareil et le corps dʼune personne.

EU compliance statement

Apple Inc. hereby declares that this wireless device is in compliance with Directive
2014/53/EU.

A copy of the EU Declaration of Conformity is available at .
Appleʼs EU representative is Apple Distribution International, Hollyhill Industrial Estate,
Cork, Ireland.

Use Restriction

This device is restricted to indoor use when operating in the 5150 to 5350 MHz
frequency range. This restriction applies in: AT, BE, BG, CH, CY, CZ, DE, DK, EE, EL, ES,
FI, FR, HR, HU, IE, IS, IT, LI, LT, LU, LV, MT, NL, NO, PL, PT, RO, SE, SI, SK, TR, UK.

Declarations of Conformity
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Japan VCCI Class B Statement

ENERGY STAR® Compliance Statement

As an ENERGY STAR partner, Apple has determined that standard configurations of this
product meet the ENERGY STAR guidelines for energy efficiency. The ENERGY STAR
program is a partnership with electronic equipment manufacturers to promote energy-
efficient products. Reducing energy consumption of products saves money and helps
conserve valuable resources.

Mac mini is shipped with power management enabled with the computer set to sleep
after 10 minutes of user inactivity. To wake your computer, click the mouse or press any
key on the keyboard. To change this setting, click the System Preferences icon  in the
Dock, then click Energy Saver.

Mac mini meets the ENERGY STAR guidelines for energy efficiency. For more information
about ENERGY STAR, go to .

Apple and the environment

At Apple, we recognize our responsibility to minimize the environmental impacts of our
operations and products.

For information, go to Appleʼs  website.

Energy Star

Environment
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Disposal and recycling information

This symbol indicates that this product and/or battery should not be disposed of with
household waste. When you decide to dispose of this product and/or its battery, do so in
accordance with local environmental laws and guidelines.

For information about Appleʼs recycling program, recycling collection points, restricted
substances, and other environmental initiatives, go to Appleʼs  website.

Información sobre eliminación de residuos y reciclaje

El símbolo de arriba indica que este producto y/o su batería no debe desecharse con los
residuos domésticos. Cuando decida desechar este producto y/o su batería, hágalo de
conformidad con las leyes y directrices ambientales locales. Para obtener información
sobre el programa de reciclaje de Apple, puntos de recolección para reciclaje, sustancias
restringidas y otras iniciativas ambientales, visite  o 

.

Brasil – Informações sobre descarte e reciclagem

O símbolo acima indica que este produto e/ou sua bateria não devem ser descartados no
lixo doméstico. Quando decidir descartar este produto e/ou sua bateria, faça-o de acordo
com as leis e diretrizes ambientais locais. Para informações sobre substâncias de uso
restrito, o programa de reciclagem da Apple, pontos de coleta e telefone de informações,
visite .

European Union—Disposal Information

The symbol above means that according to local laws and regulations your product
and/or its battery shall be disposed of separately from household waste. When this
product reaches its end of life, take it to a collection point designated by local authorities.
The separate collection and recycling of your product and/or its battery at the time of
disposal will help conserve natural resources and ensure that it is recycled in a manner
that protects human health and the environment.

Software License Agreement

Use of Mac mini constitutes acceptance of the Apple and third-party software license
terms found at .

Environment

Medio ambiente Si damos más de
nosotros, tomamos menos del planeta

Meio ambiente

Software License Agreements
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Apple Inc.
© 2018 Apple Inc. All rights reserved.

Use of the “keyboard” Apple logo (Option-Shift-K) for commercial purposes without the prior written consent
of Apple may constitute trademark infringement and unfair competition in violation of federal and state laws.

Apple, the Apple logo, AirDrop, AirPlay, AirPods, AirPort, AirPort Time Capsule, AirPrint, Apple Music,
Apple Pay, Apple TV, Apple Watch, Face ID, FaceTime, Finder, FireWire, Flyover, GarageBand, Handoff, iMovie,
iPad, iPhone, iPod, iPod touch, iTunes, iTunes U, Keynote, Launchpad, Lightning, Mac, Mac mini, macOS,
Magic Mouse, Magic Trackpad, Mission Control, Numbers, Pages, Safari, Siri, Spaces, Spotlight, Time
Machine, Touch ID, and watchOS are trademarks of Apple Inc., registered in the U.S. and other countries.

Apple Books, Live Photos and tvOS are trademarks of Apple Inc.

AppleCare, Apple Store, App Store, iCloud, iCloud Drive, and iTunes Store are service marks of Apple Inc.,
registered in the U.S. and other countries.

Apple
One Apple Park Way
Cupertino, CA 95014
USA

IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under license.

The Bluetooth® word mark and logos are registered trademarks owned by Bluetooth SIG, Inc. and any use of
such marks by Apple Inc. is under license.

ENERGY STAR and the ENERGY STAR mark are registered trademarks owned by the U.S. Environmental
Protection Agency.

Other company and product names mentioned herein may be trademarks of their respective companies.

Every effort has been made to ensure that the information in this manual is accurate. Apple is not responsible
for printing or clerical errors.

Some apps are not available in all areas. App availability is subject to change.

www.apple.com
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